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ATTACHMENT A

TRAINING SUMMARY TABLE

Type of training; general Location held/ Number of Presenter(s) Outlines, presentations, and/or
description, length Dates personnel who documents distributed
attended, by
position “excel” = Microsoft Excel Doc
“ppt” = Microsoft Power Point Presentation
“pdf” = Portable Document Format
“word” = Microsoft Word Doc
1. PBIS#1 1010 E 10" st. 5 LSCs (new Karen Ward e Intro to PBI Systems (word)
9/15/14 LSCs) e PBIS Info (word)
e What is PBIS (ppt)
2. PBIS#2 1010 E 10" st. 15 LSCs Karen Ward e Components and Elements (pdf)
10/14/14 e PBIS Form (pdf)
e Behavior is Learned (ppt)
e Decision_making (ppt)
e Why PBIS (ppt)
3. PBIS#3 1010 E 10" st. 23 LSCs Karen Ward e Data Collection Major and
11/12/14 3 Site Reps Minor Incidents (pdf)
e Data Management (excel)
e DataManagementUsingExcel
(pdf)
e PBIS World.com Home Page
(pdf)
e Data Collection and Progress
Monitoring for Behaviors (ppt)
4. RESTORATIVE 1010 E 10" st. 16 LSCs Tsuru Bailey- e Introduction to Restorative
PRACTICES (INTRO) 1/26/15 2 Admins Jones Practices (ppt)
4 Cert Staff
1
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Type of training; general Location held/ Number of Presenter(s) Outlines, presentations, and/or
description, length Dates personnel who documents distributed
attended, by
position “excel” = Microsoft Excel Doc
“ppt” = Microsoft Power Point Presentation
“pdf” = Portable Document Format
“word” = Microsoft Word Doc
5. RESTORATIVE 1010 E 10" st. TBD Tsuru Bailey- e TBD
PRACTIVES (CIRCLES) February 2015 Jones
6. YOUTH MENTAL Duffy 2/2/15 17 LSCs Tsuru Bailey- e Youth Mental Health — First
HEALTH, FIRST AID 1 Classified Jones (in Aid USA Manual (manual)
TRAINING conjunction
with La
Duffy 2/3/15 26 LSCs Frontera and
2 Counselors Community
Tentative, final Partnership of
attendance is not | Arizona)
yet known
7. ADMINISTRATOR Santa Rita JTED 7/14: Eugene Butler; | e Formal Discipline Training for
TRAINING (FORMAL Center 118 Admin Charlotte Administrators (ppt)
DISCIPLINE TRAINING) 7/14/14 - 7/15/14 1 Cert Staff Brown; Nancy
Woll; Elaine
7/15: House
108 Admin
8. ADMINISTRATOR Duffy 10/2/14 91 Admin Dr. Adrian e Guidelines for Student Rights
TRAINING Vega and Responsibilities (ppt)
(UNDERSTANDING THE
USP AND GSRR)
9. ADMINISTRATOR Palo Verde Cyber 101 Admin Eugene Butler e N/A
TRAINING (FIRST Café
QUARTER DISCIPLINE
DATA) 11/6/14
2
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Type of training; general
description, length

Location held/
Dates

Number of
personnel who
attended, by

Presenter(s)

Outlines, presentations, and/or
documents distributed

position “excel” = Microsoft Excel Doc
“ppt” = Microsoft Power Point Presentation
“pdf” = Portable Document Format
“word” = Microsoft Word Doc
10. ADMINISTRATOR Palo Verde Cyber 77 Admin Eugene Butler, e Interventions and Discipline
TRAINING Café 1 Classified Charlotte Actions (ppt)
(INTERVENTIONS AND (AM) Brown, Tsuru
DISCIPLINE ACTIONS) 12/11/14 Bailey-Jones,
Roxanne
Begay-James
(AM)
Eugene Butler,
81 Admin Charlotte
(PM) Brown, Jimmy
Hart, Maria
Figueroa (PM)
11. ADMINISTRATOR Palo Verde Cyber 69 Admin Abel Morado; | N/A
TRAINING (DISCIPLINE Café (AM) Ana Gallegos
DATA - CORRECTIVE
ACTION FORMYS) 1/8/14
36 Admin
(PM)
3
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Type of training; general Location held/ Number of Presenter(s) Outlines, presentations, and/or
description, length Dates personnel who documents distributed
attended, by
position “excel” = Microsoft Excel Doc
“ppt” = Microsoft Power Point Presentation
“pdf” = Portable Document Format
“word” = Microsoft Word Doc
12. ONLINE GSRR TRAINING | Online (TNL) TBD TNL e Online GSRR Training from
True North Logic (ppt)
November 2014 —
March 2015
13. LSC TRAINING (MTSS) 8/21 All LSCs Richard Foster; | N/A
9/5 LSCs
9/19
10/17
10/24
11/21
1/9/15
1/23/15
14. LSC TRAINING (GSRR - Students Beginning of Site LSCs e School Culture, Student
STUDENTS) each semester; and/or Expectations, and Discipline
twice per year Principals [for students] (ppt)
15. LSC TRAINING (GSRR - Parents Beginning of Site LSCs e School Culture, Student
PARENTYS) each semester; and/or Expectations, and Discipline
twice per year Principals [for parents] (ppt)
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Dutnoduciion to
Pooctive Behavional Tutenventions and Swupponts
September 5, 2014

Planning Process

o Form PBIS Committee (Have a well represented team.)

o Take a look at what your school already has in place for
expectations. Are there things that could fit under the
umbrella of PBIS?

e Select 3-4 expectations that you would like to present
to the staff. If 80% of the staff would really like
something else then the team can meet with staff to see
if the expectations can be reasoned out. The
expectations must be stated in a positive tone.

Implementation

e Matrix (Student Expectations) during this step you will
look at where and when most misbehavior occurs.

o Select behavior for each part of the matrix (limit to 4 if
you can)
Here is the most important piece of information for your
behavioral expectations they must be observable /
measurable with meaningful data collection

o Next, how will you teach the behavioral expectations on you
newly designed Matrix?

« How will every adult in your school recognize and
acknowledge positive behavior?

« How will every adult in your school recognize and
acknowledge positive behavior?

1. PBIS #1 (Intro to PBI Systems (word)) VI-58 p- 5
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PBIS Information & Practices

Be Respectfull Be Responsible! Be Prepared!

What is PBIS? The underlying theme of PBIS is teaching behavioral expectations in the same
manner as any core curriculum subject. The emphasis is on school-wide systems of support that
include proactive strategies for defining, teaching, and supporting appropriate student
behaviors to create positive school environments.

Why use PBIS? Teaching behavioral expectations and rewarding students for following them is
a much more positive approach than waiting for misbehavior to occur before responding. The
purpose of school-wide PBIS is to establish a climate in which appropriate behavior is the
norm.

School-Wide and Classroom Expectations: All feachers should plan to teach students the
school-wide matrix and classroom procedures. Your classroom procedures and MATRIX should
be clearly posted in your classroom. If you need MATRIX posters please let me know.

Please add these teaching moments to your lesson plans!

e Playground Expectations: Discuss and model playground expectations with students.
Expectations for using the equipment, play area boundaries, safety precautions and lining
up at the end of recess as well as other items listed on the school matrix should be
discussed.

e Cafeteria Expectations: Discuss and model cafeteria expectations prior to lunch and
practice cafeteria line procedures, keeping areas clean, lunch numbers, manners, and
dismissal procedures.

e Restroom Expectations: Discuss and model procedures bathroom expectations with
students including how to line up for the restroom, the number of students allowed in
restroom at one time, privacy of others, flushing, washing hands and keeping restrooms
clean.

e Hallway Expectations: Discuss and practice hallway expectations such as walk to the
right, panther pride profile, personal space, keeping up with your class and stopping
points. Practice, practice, practice!

o Bus Expectations: Discuss and practice dismissal procedures, bus lot behavior, locating
designated bus, boarding procedures, BEHAVIOR WHILE RIDING THE BUS and exiting
the bus. All students will ride a bus at some point this year and all students need to
review and practice bus behavior.

e Assembly Expectations: Please talk with students about the expectations prior to any
assembly.

e Classroom Expectations: Discuss model and practice matrix expectations for the
classroom and ensure students are aware of the individual classroom procedures you have
in placel

Panther Pride Panther Pride will be: hands at sides or behind your back, walking to the right,
keeping away from walls and bulletin boards, straight line & keeping up with class.

1. PBIS #1 (PBIS Info (word)) VI-58 p. 6
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STOP SIGNS: Red STOP signs are placed around the building and are to be used
as stopping points for students when traveling in the hallways.

(X
-

STAR STUDENTS:

Each classroom teacher will pick a student of the week. This student should be one that has
exhibited positive behavior that week. This can be the student that has shown an improvement
in behavior or a student that “always” behaves. Teachers will submit the name of their student
on Fridays (or the last day of the school week). Nomination lists will be placed in each teacher’s
mailbox. Every classroom teacher needs to nominate a student. Monday morning the Star
Students from the previous week will be announced. Students will have their picture taken and
given a reward for their achievement.

X
STUDENT OF THE MONTH: <%
Each Star Student's name will be placed in a box for a Student of the Month drawing. There

will be a Student of the Month for each grade level. This student will be announced at the end
of the month and will participate in a monthly pizza party.

BUS STUDENT OF THE WEEK:

Bus drivers will nominate an outstanding bus student each week. This student should be one
that has exhibited positive bus behavior that week. This can be the student that has shown an
improvement in behavior or a student that "always” behaves. Bus Drivers will be given slips to
put their nomination and the slips will be placed inside a box by the sign-in sheets on Friday
mornings. Monday morning the Bus Students of the Week will be announced. Students will have
their picture taken. All of the Bus Students of the Week pictures will be posted.

ATTENDANCE:

Attendance awards are given monthly to one class per grade level with the best attendance. If
attendance is a tie the team will look at late arrivals to break the tie. Classrooms will receive a

1. PBIS #1 (PBIS Info (word)) VI-58 p. 7
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small treat and the classes will be announced over the intercom. Classes will get a certificate to
hang outside the classroom door.

GOLD KEY STUDENTS:
Gold Key students are recognized twice a year at the school board meetings. We are allowed 4
nominations. Students are only allowed to receive this award once in their school career.
Students may be recognized for the following:

e Student is a role model for other students.

e Student has shown involvement in his/her community.

e Student has shown an improvement in behavior/attitude/achievement.

e Student consistently displays positive character traits.

e Student gets along well with peers and adults.

e Student has gone above and beyond to help another student.

SOCIAL SKILL LESSONS:

Teachers should have received via email short (5-10 minutes) social skill lessons/outlines that
should be discussed with students on scheduled dates. All the elementary schools in the county
will be doing the same short lessons. The PBIS team decided that these lessons can be
incorporated into your Daily 5 routine on the specified dates.

d
<)) 2

FEATURED TEACHER: == ¥

Featured Teacher forms have been placed in each teacher's mailbox. The forms should be
completed and turned back in fo Mrs. Joyce. Mrs. Joyce will announce the Featured Teacher
and the information will be placed on the "Featured Teacher” bulletin board.

™)

[ [
PANTHER BUDDY:

This program is optional and was put in place to raise staff morale. Staff members sign up and
are assigned a secret panther buddy. The buddy is to give notes of encouragement and/or small
treats during the year. At the end of the year a social will be held o reveal buddies.

1. PBIS #1 (PBIS Info (word)) VI-58 p. 8
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What is Positive Behavior Interventions
and Supports (PBIS)?

*Evidence-based process for schools
to improve students behavior

*Framework that establishes a positive
school culture

*Proactive positive approach to school-
wide discipline system

What is Positive Behavior Interventions and
Supports (PBIS)?

PBIS is a process for creating safer and
more effective schools by focuses on
improving a school’s ability to teach and
support positive behavior for all students.

1. PBIS #1 (What is PBIS (ppt)) VI-58 p. 9
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PBIS teaches appropriate behavior to all
students by developing procedures to
accomplish 4 goals.

Goal 1. Behavioral Expectations are Defined.

* A small number of behaviors
» Clearly defined in positive , simple rules or procedures

+ Be Respectful
+« Be Responsible
+ Be Safe

+ Respect Yourself
+ Respect Others
+ Respect Property

PBIS teaches appropriate behavior to all
students by developing procedures to
accomplish 4 goals.

Goal 2. Behavior Expectations are Taug ht.

Behavioral expectations are taught in real settings: in the
classroom, in the hallways and cafeteria, on the playground and
other common areas

Describe what each rule means and looks like in each of the settings

Example—Being Respectful in the classroom means raising your
hand when you want to speak.

Example—Being Respectful in the cafeteria means using a
person’s name when you talk to him or her

1. PBIS #1 (What is PBIS (ppt)) VI-58 p. 10
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PBIS teaches appropriate behavior to all
students by developing procedures to
accomplish 4 goals.

Goal 3. Appropriate Behaviors are Acknowledged.

« Once appropriate behaviors have been defined and taught, they
need to be acknowledged on a regular basis.

« Acknowledgement may be done through a formal system like
tickets, coupons.

* Acknowledgement may be done through social events where
students are recognized.

Note: Adult interactions with students should be based on a 4:1 ratio,
meaning 4 positive interactions to 1 negative interaction

PBIS teaches appropriate behavior to all
students by developing procedures to
accomplish 4 goals.

Goal 4. Behavioral Errors are Corrected
Proactively.

» Clear procedures are needed to provide information to
students that their behavior was unacceptable

» Clear procedures are needed to prevent the
unacceptable behavior to receive inadvertent rewards or
attention

1. PBIS #1 (What is PBIS (ppt)) VI-58 p. 11
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PBIS includes school-wide procedures and
processes intended for:

* ALL students, ALL staff and in ALL settings
* Non-classroom settings within the school environment
+ Individual classrooms and teachers

+ Individual student supports for the estimated 3-7% of
students who present the most challenging behaviors

PBIS uses a 3-Level Support Approach

Intensive

Individualized
interventions 5%

Secondary

aimed for targeted
students 15%

Universal

School-wide foundation for all students 80%

1. PBIS #1 (What is PBIS (ppt)) VI-58 p. 12
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Why Do Schools Need PBIS?

Discipline issues affect the entire school
community!

* Too many students leave school, one way or another,
because of school discipline.

* Teacher attrition is directly connected to discipline issues
(half of new teachers are no longer in the profession by
their fifth year)

Why Do Schools Need PBIS?

» Reduce office referral rates

* Improve attendance and school engagement
» Improve academic achievement

* Reduce dropout rates

1. PBIS #1 (What is PBIS (ppt)) VI-58 p. 13
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Why Do Schools Need PBIS?

* Reduce delinquency in later years
* Improve school climate
* Reduce referrals to Special Education

Steps to Develop a PBIS Plan

1. Staff Recognition of need—based on data

2. Preplanning—form a planning and implementation
team

3. Rules and Procedures—create 3-5 school-wide
behavioral expectations

4. Develop Behavioral Expectations—matrix showing
what expectations would look like in each setting,
classroom, in the hallways and cafeteria, on the
playground and other common areas

1. PBIS #1 (What is PBIS (ppt)) VI-58 p. 14
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Steps to Develop a PBIS Plan

5. Conduct Staff Training/Orientation on PBIS
Implementation Plan—introduce program, common
language and reinforcements

6. Design Process for Teaching the Behavioral
Expectations to All Students—taught in all school
areas through role-plays with specialized training for
areas that show high incidences of problem behaviors

7. Behavioral Expectations Taught —based on matrix

Steps to Develop a PBIS Plan

8. Develop Plan for Acknowledging & Recognizing
Appropriate Behaviors—verbal recognition, assembly,
stickers, call home

9. Design Consequences System for Reducing
Inappropriate Behavior—teaching vs. punishment with
respect to TUSD discipline rubric, state, and federal law

10. Administrative Support and Reinforcement—critical to
successful implementation: commitment of key
administrators

1. PBIS #1 (What is PBIS (ppt)) VI-58 p. 15



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 16 of 225

Steps to Develop a PBIS Plan

11. Teacher Support and Reinforcement —critical to
successful implementation: commitment of 80% of
school’s teachers

12. Individual Support Systems are Integrated School-
wide—provide additional interventions as necessary for
students in the second and top tier of the support
pyramid

13. Plan for Periodic PBIS Team Meetings, Staff
Feedback, Promotion and Program Evaluation—ongoing

PBIS Provides the Building Blocks of
Positive Behavior

You can be an agent for change at your school!

BE informed
Be Involved
Be ready to make a difference

Believe (PBIS) Positive Behavior Interventions Supports
WORKS and can create a caring, safe, and positive
learning environment at your school!

1. PBIS #1 (What is PBIS (ppt)) VI-58 p. 16
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M UNIVERSITY OF MINNESOTA

Driven to Discover® Search 101

Institute on Community Integration CEHD | College of Education + Human Development

RESEARCH TRAINING & CONSULTATION IMPLEMENTATION ONLINE RESOURCES
CONTACT US

Inside About Check &
Connect

" Components/Elements of Check & Connect
® Emphasis on Student Engagement

The Components and Elements of Check & Connect

Check & Connect has four main components and three main elements:

Components Of CheCk & ConneCt ® Using Check & Connect with Existing

1. The Mentor: A person assigned to a specific student(s) who builds a strong relationship with Initiatives (PBIS, Rtl, etc.)
him/her based on mutual trust and open communication, nurtured through a long-term

. :
commitment focused on success at school and with learning. This person may be called a
mentor, monitor, graduation coach, intervention specialist, etc. = Acknowledgements
2. "Check" Component: Systematic monitoring of student performance variables (warning signs of ® Participant Interviews and Testimonials
disengagement such as attendance, grades, and behavior referrals) using data readily available
to school personnel. "Everything about our school feels better when
students feel engaged, and they're engaged when
3. "Connect" Component: Timely, personalized, data-based interventions designed to provide they're successful, when people care about them,

and when they belong. Check & Connect has a
benefit both for the students in their individual
success, as well as for the school and our culture

support tailored to individual student needs, based on the student's level of engagement with
school (“check” data), associated influences of home and school, and leveraging of local

resources. and our overall success in accomplishing our
mission."
4. Parent/Family Engagement: Mentors partner with parents/families. They work with caseloads of
students and families for at least two years, functioning as liaisons between home and school - Dave Brecht, Principal, Chaska High School,
and striving to build constructive family-school relationships. Chaska, MN

Elements of Check & Connect

1. Relationships: Are based in mutual trust and open communication and nurtured through a long-
term commitment focused on promoting a student’s educational success. View Intro PPT (18 min.)
« Focus on alterable variables: Refers to systematic monitoring (i.e., "checking") of indicators of
disengagement (attendance, grades, behavior) that are readily available to school personnel and can
be altered through intervention. Download flyer (PDF)

« Personalized, data-based intervention: Refers to “connect” interventions, which are supportive
interventions that are personalized, not prescriptive. Mentors use data—including information on the
student’s needs (“check” data and student perspective), family circumstances, and availability of
school and community resources—as the basis for intervention design. It is expected that different
students on a mentor’s caseload will receive different interventions.

Download brochure (English or

Spanish)
« Long-term commitment: Means that interventions are implemented for a minimum of two years.
Mentors make a two-year commitment, which may involve following highly mobile youth and
families from school to school and program to program within a district.
« Participation and affiliation with school: Means that mentors facilitate student access to and
active participation in school-related activities and events. Check & Connect Manual
2. Problem Solving and Capacity Building: Means a cognitive-behavioral approach is used to The 2012 edition of the Check &
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promote the acquisition of skills to resolve conflict constructively, encourage the search for Connect manual, Implementing with
Fidelity, is a comprehensive guide

solutions rather than a source of blame, foster productive coping skills, and diminish
to implementing Check & Connect.

dependency on the mentor.

3. Persistence Plus: Refers to persistence, continuity, and consistency. The mentor is a persistent
source of academic motivation, is familiar with the youth and family (continuity), and conveys
the message that “education is important for your future” (consistency).
Connect with Us!

discussion updates

Read & Follow Our Blog

Attend-Engage-Invest is a blog forum to share
perspectives on Check & Connect, dropout,
student engagement, and related topics.

Frequently Asked Questions

Check & Connect Student Engagement Intervention, Institute on Community Integration, U of MN
6 Pattee Hall, 150 Pillsbury Dr SE, Minneapolis, MN 55455 | checkandconnect@umn.edu | Toll free 866-434-0010 | 612-624-2097

© 2014 Regents of the University of Minnesota. All rights reserved. The top banner photographs used on this website are for illustration purposes only. |

The University of Minnesota is an equal opportunity educator and employer. Check & Connect Student Engagement Intervention: Contact Us | ICl | CEHD | Privacy
Last modified on July 24, 2014 UMN-Twin Cities: Parking & Transportation | Maps & Directions | Directories | U of MN
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Positive Behavior intervention System

PBISis a ,hota

OBJECTIVE:

There are 4 objectives for today:

1. The objective of PBIS is to create a school-wide discipline system of support that includes

pro-active strategies for , and

appropriate student behaviors to create

school environments.

2. There are four messages from PBIS:

- that are justifiable and measureable

on-going decision making that is

evidence-based

- ensuring durable, high-fidelity of implementation

NECESSITIES:

3. What do you need to implement PBIS?

[ ]
[

[ ]

Place an X in the box next to each “necessity” that you’ve already implemented.

HEn
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MATRIX:

4. There are 3 commonalities to having a matrix:

5. There are 3 benefits to having a matrix:

a. Aclear set of expectations and behaviors.
b. to area and location.
C. ' , not reactive.

6. A school-wide PBIS system allows us to have:

Have fun with teaching the matrix. Students love to see teachers acting silly.

FLOW CHART:
7. The purpose of a flow chart is that it provides:

a. common and to discipline.

b. procedures for and

8. PBIS says misbehaving students are looking for one of two things:
a.

b.

DATA COLLECTION:
9. Data collection provides a coordinated focus on:

a.

b.

2. PBIS #2 (PBIS Form (pdf)) VI-58 p. 20
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7

10. The benefits of data collection are that:

a. Decisions are more likely to be and

when they are based on data.

b. Data helps us

11. Use data to:

a. problems.
b. questions that lead to solutions.
C. changes.

Data Analysis
12. Benefits of analyzing data:

a. indicators of behavior.

b. Helps place the problem in the rather than in the student.

Implementing Change

13.

Remember to share changes and successes with staff. Provide staff with the data facts.

2. PBIS #2 (PBIS Form (pdf)) VI-58 p. 21
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Acknowledge and Recognize

14. Create rewards for:

Useful websites:

http://www.pbis.org/

http://www.michigan.gov/documents/mde/SchoolwidePBS 264634 7.pdf

http://www.pbis.org/training/student.aspx

http://www.pbis.org/swpbs videos/default.aspx

2. PBIS #2 (PBIS Form (pdf))
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POSITIVE BEHAVIORAL
INTERVENTION SUPPORTS

LEARNING SUPPORT COORDINATORS
SESSION 2-OCTOBER 14, 2014

©
« X

BEHAVIOR IS
LEARNED AND
CAN BE TAUGHT

2. PBIS #2 (Behavior is Learned (ppt)) VI-58 p. 23
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FOUR ESSENTIAL ELEMENTS

+*CLARITY-plan, expectations and procedures

clear to all

+*CONSISTENCY- school and family using the
same plan, expectations and rewards

+*SIMPLICITY-simple, practical, accessible

+*CONTINUATION-even as behavior improves it
is important to keep the teaching and the
positive supports in place

COMPARISON OF TRADITIONAL BHEAVIOR
MANAGEMENT AND POSITIVE BEHAVIORAL SUPPORT

Traditional Behavior Management

Positive Behavioral Support

« Views individual as “the problem”
% Attempts to “fix” individual

<+ Extinguishes behavior

¢ Takes days or weeks to “fix” a single
behavior

¢ Implemented by a behavioral
specialist

» Often resorted to when systems are

inflexible

2. PBIS #2 (Behavior is Learned (ppt))

«* Views systems, settings, and skill
deficiencies as “the problem”

< Attempts to “fix” systems,
settings, and skills

«+ Creates new contacts,

experiences, relationships, and

skills.

<+ Takes years to create responsive
systems, personalized settings,
and appropriate/empowering
skills.

< Implemented by a team

% Flourishes when systems are

flexible

VI-58 p. 24
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REVIEW

**WHERE IS THE MATRIX?
IS THERE COMMON LANGUAGE?

IS THERE A SYSTEM WIDE FOCUS ON POSITIVE
BEHAVIOR?

“*WHAT DID YOU PUT IN PLACE FOR NEW
STUDENTS?

**HAVE YOU HELD A “KICK OFF” ASSEMBLY?

MAKING IT HAPPEN

* PLANNING ANOTHER STAFF DEVELOPMENT
* TEACHING BEHAVIOR EXPECTATIONS

* DEVELOP PLAN FOR RECOGNIZING
APPROPRIATE BEHAVIORS

* DESIGN CONSEQUENCES SYSTEM FOR
REDUCING INAPPROPRIATE BEHAVIOR

* INDIVIDUAL SUPPORT SYSTEMES ARE
INTEGRATED SCHOOL WIDE

2. PBIS #2 (Behavior is Learned (ppt)) VI-58 p. 25
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GROUP ACTIVITY

THINK OF 10 THINGS YOU SAY ALL THE TIME
THAT ARE DIRECTIVES AND FIGURE OUT HOW
TO MAKE THEM ENFORCEABLE STATEMENTS.

CHOICES

A. You're welcome to or

B. Feel free to or

C. Would you rather or

D. What would be best for you or

2. PBIS #2 (Behavior is Learned (ppt)) VI-58 p. 26



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 27 of 225

PRESISTENT PROBLEMS

TRY SAYING: I’'M GOING TO HAVE TO DO
SOMETHING. I'M NOT SURE WHAT JUST YET.
TRY NOT TO WORRY TOO MUCH ABOUT IT.
I’LL LET YOU KNOW WHEN | DECIDE HOW I'M
GOING TO RESPOND.

2. PBIS #2 (Behavior is Learned (ppt)) VI-58 p. 27
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Active Decision-making:
Transforming Data into Useful Information

Rob Horner, Anne Todd, Steve Newton,

Bob Algozzine, Kate Algozzine

www.pbis.org
WWW.SWis.org
www.pbssurveys.org

S
Goals

O Logic for school-wide Positive Behavior
Support

O Design of “decision-systems” for schools

O Collection and use of data for decision-
making
= Whole school
= Targeted groups
® Individual student

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 28
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Main Messages

O Supporting social behavior is central to achieving
academic gains.

O School-wide PBS is an evidence-based practice for
building a positive social culture that will promote
both social and academic success.

O Implementation of any evidence-based practice
requires a more coordinated focus than typically
expected.

What is
School-wide Positive Behavior Support?
O School-wide PBS is:

o A systems approach for establishing the social culture and
individualized behavioral supports needed for schools to achieve both
social and academic success for all students.

O Evidence-based features of SW-PBS

Prevention

Define and teach positive social expectations
Acknowledge positive behavior

Arrange consistent consequences for problem behavior
On-going collection and use of data for decision-making
Continuum of intensive, individual interventions.

Ooo0Ooooaoao

Administrative leadership — Team-based implementation (Systems that
support effective practices)

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 29



Common
Language

Establishing a Social Culture

Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 30 of 225

stout[]
eur[oIe)) YLON.
opeiojo)
pueiArepy
w0210

I0A MON
eueISINOT
epHOL|
ueByIIN
temeH

omo

unossiy
vwiequ]y
vuRUON
9ssaua
eI 1S9M
Ayomuayy
urjoxe)) yinog
emof

widi000
anysduwep moN.
001X MON
el
eUISLIA
BwIoHE)
sesuey]
NJMOAUU0))
e

BJOSIUUIIA
sexa
Suwoky

Q1)S UOISUIYSEAY
SuaSIoSSEI
vuozy

O uoBurysep
JuouLdA
ToYeq YUON.
BIURAASUUDG
Bodeq ynos
sesueyIy

Common
ision/Values

school-wide positive behavior support

on
=]
=
=]
2
=]
2
&
8
w2
Q
2
<
S
2]
<
<
w2
w2
S
=
Q
<
2]
=
(=]
=}
=
3]
wn
(=2
(=3
el
o~

Rosiof MON
epEAN
wsuoost
pue[s| apouy
L)
eyseY

ouepy

1ddrssisstg
urey
euvipuy

800
700
600
500
400
300
200
100

VI-58 p. 30

2. PBIS #2 (Decision_making (ppt))



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 31 of 225

Six Basic Recommendations for
Implementing PBIS

O Never stop doing what is already working

0O Always look for the smallest change that will produce
the largest effect
O Avoid defining a large number of goals
o Do a small number of things well

0 Do not add something new without also defining
what you will stop doing to make the addition
possible.

Six Basic Recommendations for
Implementing PBIS

O Collect and use data for decision-making

O Adapt any initiative to make it “fit” your school
community, culture, context.
o Families
o Students
o Faculty
o Fiscal-political structure

O Establish policy clarity before investing in

implementation
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Tertiary Prevention:
Specialized

SCHOOL-WIDE Individualized
POSITIVE BEHAVIOR 4\5 Systems for Students
SUPPORT with High-Risk Behavior

Secondary Prevention:
Specialized Group
Systems for Students
with At-Risk Behavior

Primary Prevention:
School-/Classroom-
Wide Systems for
All Students,
Staff, & Settings

Michigan: Distribution of Elementary Reading
Intervention Level

100% -

90% - 24%
56%
80% -
Steve
70% -
60% - 33%
Amanda
50% -
40% -
24% e
30% - >
20% - 43%
Kent
o 20%
0% ~ |
(n = 4074) All Students i Students with 6+ ODRs (n=201) _Miora
Reading Intervention Level (based on DIBELS) »
B Benchmark O Strategic ® |ntensive Dr. Steve Goodman
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—
Using Data within PBIS

O Use data to assess current status

o EBS Self-assessment Survey

O Use data to assess implementation fidelity
m}

D pbssurveys.org

o Benchmarks of Quality (BoQ)

0 Use data to assess impact on students

o Office Discipline referrals

Use Data for Decision-making

O “We are all continually faced with a series of
great opportunities, brilliantly disguised as

insoluble problems.”
John Gardner

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 33
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|
Main Ideas

O Decisions are more likely to be effective and
efficient when they are based on data.

O The quality of decision-making depends most
on the first step (defining the problem to be
solved)

o Define problems with precision and clarity

RS
Main Ideas

O Data help us ask the right questions...they do
not provide the answers: Use data to
= Identify problems

= Refine problems

m Define the questions that lead to solutions

O Data help place the “problem” in the context
rather than in the students.

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 34
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e —
Main Ideas

0 The process a team uses to “problem solve” is
important:
m Roles:

= Facilitator; Recorder; Data analyst; Active member

m Organization

= Agenda; Old business (did we do what we said we would
do); New business; Action plan for decisions.

What happens BEFORE| Agenda, data summary, positive nag
®  What happens DURING]| Updates, identify problem, problem solve
= What happen AFTER a { Minutes posted, tasks completed

Decision-making at many levels

0 Whole school
O Small groups or school areas

O Individual student

O Same basic process

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 35
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Team Initiated
Problem Solving
(TIPS) Model

—————————————————
Using Data

O Use data to identify a possible problem?
O Use data to build a precise “problem statement?
O Use data to select a solution (intervention)

O Use data to assess if a solution is (a) being
implemented, and (b) being effective.

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 36
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2

Use data within “decision systems’
not “data systems”

Question Decision Data Source

Is there a problem? Should we allocate resources Compare “observed” with

Primary/Precise problem statement.  to this problem? “expected” (ODRs, ORF)

Is there a reasonable Do we have a reasonable Technical adequacy

solution? intervention, and should it be Contextual Fit
implemented?

Is the intervention being Do we need more resources  On-going data related to

implemented as planned? to implement the fidelity of implementation
intervention?

Is the intervention proving Should we continue the On-going data related to

effective? intervention, modify it, or impact of the intervention on
terminate it? student behavior

e
Using Data

O Use data in “decision layers”

O Don’t drown in the data

o It’s “OK” to be doing well

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 37
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? Problem ?

Beh Location Tir?e Student
o

Setting A

B C DEF G H 1 J K
Locations 1 2 3 4 5 6 7 8 9 10
Times A B CDE FGHI J K
Students 1 2 34 5 6 7 8910 11
Problem ?
.
Systems ?
. . . .

2. PBIS #2 (Decision_making (ppt))
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Problem ?

l Systems ?
. . .

oooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooo

Problem ?

Systems ?

- e Local/Individual ?
..........................
...........................

..............................

ooooooooooooooooooooooooooooooo
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Problem ?

\ Systems ?

Six things to avoid

O

Define a solution before defining the problem
Build solutions from broadly defined, or fuzzy problem statements
Failure to use data to confirm/define problem

Agree on a solution without building a plan for how to implement
or evaluate the solution

Agree on a solution but never assess if the solution was
implemented

Serial problem solving without decisions

13
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Using Data for Decision-making at the
Whole School Level

O Identifying “problems” with “precision”

= Well defined problems prompt functional
solutions

m Poorly defined problems prompt discussions in
which the problem is admired, but not addressed.

o “Well begun is half done”

= Aristotle, quoting a proverb

—————————
Precise Problem Statements
(What are the data we need for a decision?)

O Solvable problem statements include
information about the five core “W”
questions.
= What is problem, and how often is it happening
= Where is it happening
= Who is engaged in the behavior
= When the problem is most likely
= Why the problem is sustaining
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O “Everything is vague to a degree you do not
realize till you have tried to make it precise.”

®m  Bertrand Russell

Primary versus Precision Statements

o Primary Statements
= Too many referrals

= September has more
suspensions than last
year

m  Gang behavior is
increasing

m  The cafeteria is out of
control

m  Student disrespect is
out of control

2. PBIS #2 (Decision_making (ppt))

o Precision Statements

=  There are more ODRs
for aggression on the
playground than last
year. These are most
likely to occur during

first recess, with a large
number of students, and
the aggression is related

to getting access to the
new playground
equipment.

VI-58 p. 42
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Primary versus Precision Statements

o Primary Statements O Precision Statements

=  Too many referrals m  There are more ODRs

®  September has more for aggression on the
suspensions than last playground than last
year year. These are most

likely to occur during

Gang behavior i . .
 ang behavioris first recess, with a

nereasing large number of
= The cafeteria is out of students. and the
control . _ aggression is related to
= Student disrespect is getting access to the
out of control new playground

equipment.

Precise or Primary Statement?

O Children are using
with a high freg
adults and othe
sense of disrespt

s creating a
in the school

O James D. is hitting others in the cafeteria
during lunch, and his hitting is maintained by
peer attention.

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 43



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 44 of 225

Precise or Primary Statement?

0 ODRs during Decy re higher than in any other
month.

O Minor disrespect and disruption are increasing over
time, and are most likely during the last 15 minutes
of our block periods when students are engaged in
independent seat work. This pattern is most
common in 7t and 8" grades, involves many
students, and appears to be maintained by escape
from work (but may also be maintained by peer
attention... we are not sure).

Precise or Primary Statement?

O Three 51 grade boys are name calling and
touching girls inappropriately during recess in
an apparent attempt to obtain attention and
possibly unsophisticated sexual expression.

O Boys are engay t% ual harassment

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 44
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Organizing Data for Decision-making

0 Compare data across time
O Moving from counts to count/month

e
Using Data

O Identifying a possible problem: A difference
between what you want and what you have.

= What data to review?
o Office discipline referrals per day per month
o Avoid simple counts
o Avoid one data point (look at trends)

= How to use data
o Compare with national standards
o Compare with local standards
o  Compare with prior experience

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 45
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‘ Total Office Discipline Referrals as of January 10 _

Total Office Discipline Referrals

0. —

— Average Office Discipline Referrals per day per month as of January 10

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 46
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SWIS summary 07-08 (Majors Only)
2,532 schools; 1,300,140 students; 1,139,119 ODRs

Grade Range Number of Mean Enrollment | Mean ODRs per
Schools per school 100 per school

day

K-6 1762 444 35 (sd=.46)
(1/300/ day)

6-9 482 653 .92 (sd=1.42)
(1/ 110/ day)

9-12 176 914 1.06 (sd=.1.57)
(1/105/ day)

K-(8-12) 312 401 1.00 (sd=.1.86)
(17155 / day

Interpreting Office Referral Data:

Is there a problem?

O Absolute level (depending on size of school)
= Middle, High Schools (> 1 per day per 100)
= Elementary Schools (>1 per day per 300)

O Trends

m Peaks before breaks?

» Gradual increasing trend across year?

0 Compare levels to last year

= Improvement?

2. PBIS #2 (Decision_making (ppt))

VI-58 p. 47
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Application Activity: Absolute Value
Is there a Problem?

Office Discipline Referrals per Day

Sept  Oct Nov  Dec Jan Feb March April  May June

o

=

N

5]

®

o

IS

IN)

o

Office Discipline Referrals per School Day

Office Referrals ier Dai ier Month

Elementary School with 150 Students
2

ittt

Sept Oct Nov Dec Jan Feb Mar Apr May Jun
School Months

per D

RN
(@)

o
)

Ave Referrals
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Compare with National Average 1800/100 =18 18X 1.06 = 19.08
szo High School of 1800 students
—
q) p—
Q- pr—
15
@®
— M M
o pr— p—
0}
210 - HTH
o
o
05 1 H
>
<

Sept' Oct Nov Dec Jan Feb Mar Apr ' May' Jun
School Months

Office Referrals per Day per Month
> This Year

Middle School of 700 students

perl\I)Da

N
(6)

Y
(@)

(6)]

Ave Referrals

Sept  Oct "Nov Dec Jan Feb Mar Apr ' May' Jun
School Months
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Office Referrals per Day per Month

> Last Year and This Year

D a
N
o

N
(&)

Ave Referrals per
—
()] o

Sept Oct "Nov Dec Jan Feb Mar Apr ' May' Jun
School Months

Office Referrals per Day per Month

;‘ Last Year and This Year

D
N
o

N
(6)

Ave Referrals per
—
()] o

Sept Oct Nov Dec Jan Feb Mar Apr May Jun
School Months
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Middle

School

N=495 . -
Office Referrals per Day per Month
p This Year
20

-
o

a

Ave Referrals per
—
o

A Sept Oct Nov Dec Jan Feb Mar Apr May
School Months

ulg There a Problem? #2

Schoo

nAdsolute - Trend - Compare

Office Referrals per Day per Month
> This year (Middle)

perI\EJ)a
o

-
)]

-
o

(¢)]
!

Ave Referrals

Sept Oct Nov Dec Jan Feb Mar Apr May Jun
School Months
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Middle
School
N= 495 .
Office Referrals per Day per Month
g‘ Last Year and This Year
220
o _
Q- —
£15
©
210
(0]
h's
o 5
>
< Il
) Sept Oct Nov Dec Jan Feb Mar Apr May Jun
School Months
Middle
School
N= 495 i
Office Referrals per Day per Month
;‘ Last Year and This Year
?zo
a "| -
15
S _
210 1
[ ] _
e
05 IS S S-S -
>
<C

-_Sept Oct Nov Dec Jan Feb Mar Apr May Jun
School Months
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What are the data you are most likely to need to
move from a Primary to a Precise statement?

o What problem behaviors are most common?
= ODR per Problem Behavior

0 Where are problem behaviors most likely?
= ODR per Location

o When are problem behaviors most likely?
= ODR per time of day

0 Who is engaged in problem behavior?
= ODR per student

0 Why are problem behaviors sustaining?
= No graph

What other data may you want?

0 ODR by staff

o ODR by IEP

0 ODR by grade

O ODR by gender by grade
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Test precision problem statement

0 Use precision problem statement to build and
test hypotheses.

Problems are most common in D-Hall wing

Problems are more likely during second recess
Problems are most common during assembly schedule
Problems are more likely during state testing periods

[m]

[m]

[m]

What behaviors are problematic?
B Referrals per Prob Behavior

250
b

240
[«b]
[n'eg T —
H530
220
IS

S
0 I:l: —t—t— = :D:D:=':|:|:D:I:|: =

I Arson Bomb Combs DefianDis rupt Dress Agg/fgt Theft HarassProp D Skip Tardy Tobac Vand Weap
Ty pes of Problem Behavior
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What behaviors are problematic?
a Referrals per Prob Behavior

OD:::. A DD:DDDD::

Bomb Combs DefianDis rupt Dre

Ty pes of Problem Behawor

What behaviors are problematic?
a Referrals per Prob Behavior

-
a

N
o

[¢)]

Number of Referrals

sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssss

Ty pes of Problem BehaV|or
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Where are the problems occumng?
=Referrals by Location

;50
0
040
0

@ 1
10 —’~ W

= 1

< 0 l= O DDDD: =

BathR BusA Bus Caf Class Comm Gym Hall Libr PlayG Spec Other

School Locations

Where are the problems occurring?

sReferrals by Location —

€10
go'DDDT =00 m DD

BathR BusA Bus  Caf Class Comm Gym Hall  Libr PlayG Spec Other

School Locations
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Who 18 contributing to the problem?
Referra‘% per Student

N
o

-
o

Number of Referrals per S

annnnnnnnnnnﬂﬂﬂﬂHHHHH

o

Students

Wh(§: is contributing to the problem?

5Students per Number of Referrals

per

N
o

-;uunuunﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂ

o

Number oLReferraIs
o

Students
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When are the problems occurring?
Referrals by Time of Day o
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B Referrals by Time of Day
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Moving to fine-grained analysis

o SWIS Custom Reports

V'ewl Describe the challenges Neal appears to be experiencing?
Data  Student Staff Time Location Behavior
09/22/2007 Neal Dean 10:00AM Plygd ~ Disrespt  Unki N Conf
Anderson Smith i VB isrespt  Unfmown  Rone on
Neal Dean ' -
09/23/2007 o 4 ouih 10:00AM Plyed  Disrespt  Unknown Staff Loss priv
. 09/25/2007 Real 4 Dean 10:00AM Plygd ~ Disrespt Obaattn None Loss priv
Anderson Smith : Ve P! P
; 09/30/2007 Neal Dean 15 15AM Plyed  Disrespt  Unk Staff Conf
- Anderson Smith ' B srespt - Unknown St on
Neal Dean : '
1010212007 on 4 outl 10:1SAM Plygd  Disrespt  Unknown  Staff Conf
10/07/2007 Neal Dean 10:00AM Plygd  Disrespt  Unk Staff In-sch
Anderson Smith : V8 isrespt - Unfnown - St n-sch susp
Neal Dean
! 10/09/2007 e 4 ouih 10:1SAM Plyd  Disrespt  Unknown None Out-sch susp
David
11/03/2007 Anderson- 4 Jason Cline 10:00AM Class ~ M-Contact Obaattn ~ Staff Conf
Jones
David Dal
01/05/2008 Anderson- 4 ale 10:30AM Plyed ~ M-Contact Obaattn Peers Office
Jones Cocker
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NMIOVY | Describe the challenges we are experiencing in the Parking lot
Date  Student Staff Location Behavior :|

119 04012008 Mark g Dale 8:00:AM  Parklot  Tobacco Obpattn  Peers In-sch susp
Banks Cocker

120 03/13/2008 g“n]:l‘x 7 Sally Post 3:00:PM Park lot ~ M-Disrespt DK Peers Parent
ende

121 04212008 DO g Brendd oo aM Parklot  Dress Obpattn  Staff Parent
Denner Franken

122 01272008 10 7 Framie 3 opvi o Paklot  Tobacco DK Peers In-sch susp
Franklin James
Joe Carol

123 02/01/2008 7 3:30:PM Park lot Vandal Ob a attn Peers Out-sch susp
Franklin Earley

124 o01/122008  Stmual o Frammie 3 opvi parklot  Tobacco DK Peers In-sch susp
Fullerton James
y . Starla . .

125 10/30/2007  Bruce Gil 8 2:15:PM  Parklot  Skip Avoida  Staff In-sch susp

Paulson

Willie

126 03/08/2008 illie Anmf 3:30:PM Park lot Tobacco Obpattn  Peers In-sch susp
Loman Harrison

A Context for Designing Solutions

O Behavior support is the redesign of
environments, not the redesign of individuals

o Attend as much, or more, to what happens
between problem behavior bouts as what happens
during instances of problem behavior.

(Edward Carr)

o Positive Behavior Support plans define changes
in the behavior of those who will implement
the plan.
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Building Solutions

O Packages versus Practices

O Many good ideas, packages and procedures exist

O Most are expensive to implement, and not a perfect fit
with your problem

o Be efficient as well as effective

O Most good interventions will be multi-

component
o Be wary of the one-trick strategy.

Using Data to Build Solutions:
Four Elements to Consider

m]

Prevention: How can we avoid the problem context?

»  Who, When, Where

= Schedule change, curriculum change, etc

Teaching: How can we define, teach, and monitor what we want?
= Teach appropriate behavior

= Use problem behavior as negative example

Recognition: How can we build in systematic reward for desired behavior?
Extinction: How can we prevent problem behavior from being rewarded?

Conseguences: What are efficient, consistent consequences for problem
behavior?

Monitoring: How will we collect and use data to evaluate (a) implementation
fidelity, and (b) impact on student outcomes?

34
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Solution Development

Prevention

Teaching

Reward

Extinction

Corrective Consequence

Data Collection

Problem solving Mantra

0 Do we have a problem?
= (Identify the primary problem)

O What is the precise nature of the problem?

= (Define, clarify, confirm/disconfirm inferences)

O Why does the problem exist, & what should we do about it?
= (Hypothesis & solution)

0 What are the actual elements of our plan?
= (Action Plan... what will we do, who will do it, when it get done)
O Is our plan being implemented?

= (Evaluate & revise plan)

O Is the plan having the desired effect?

= (Maintain, modify or terminate the plan)
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O Quick example of the five step process with
East Elementary

O 500 students
o K-5

Step one: review status and identify problems

Rose Elementary

Enroliment: 500
students
Grades: K—-5

National Mean Level of
ODRs for Elementary
Schools is .35 per 100
students per day, or
1.75 for a school of
500 (downloaded from
www.swis.org Aug 30,
2007)
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Rose Elementary Problem Identified

1. For all but one month during last year (2004-2005), the rate of
ODRs per day exceeded the national average reported by
elementary schools across the United States

2. The data show a minimal trend across months, but there are
noticeable increases in the ODR level in December and March.

3. For each month of the last school year, the level of ODRs per day
exceeded the level from the corresponding month during the prior
school year (2003-2004)

4. Teachers, families, and students themselves have reported that
student problem behavior is unacceptable and presents a barrier to
effective instruction.

Step two: develop and clarify
hypothesis
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Rose Elementary Hypothesis

Statement

O A large proportion of students are engaging in
disruption & aggression on the playground during

recess because

= We have not developed playground specific expectations
and taught them to students

= Playground supervisors have not been included as
participants in the planning, teaching and evaluation

= Disruption and aggression are resulting in access to peer
attention and time with preferred equipment.

Step 3: Discuss and Select Solutions

Rose Elementary Example

Prevent problem behavior situation

Ensure that supervisors are on the playground and are engaged
in active supervision .

Teach appropriate behavior

Teach the school-wide behavior expectations of being safe,
respectful, and responsible, and do the teaching on the
playground where problem behaviors are most likely.

Reward appropriate behavior

Provide a formal system for playground supervisors to recognize
appropriate play on the playground.

Reduce reward for problem behavior

Teach all students to signal “stop” when they are treated
disrespectfully.

Teach playground supervisors to ensure that aggression and
disruption are not allowed to gain access to preferred activities
or materials.

Deliver corrective consequences for problem behavior

Review continuum of consequences for problem behavior on
playground with students and supervisors and make sure
continuum is in effect.

Collect data to assess if the intervention (a) is implemented with
fidelity and (b) produces desired impact on student behavior.

Collect, summarize and report data.
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Designing Solutions

O If many students are making the same mistake
it typically is the system that needs to change
not the students.

O Teach, monitor and reward before relying on
punishment. ~g”
. J

O An example (hallways) >

Examples
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Trevor Test Middle School

565 students
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N —

1200

14 Chris Black 6 Brenda 15 .00pm
Franken

15 John Candy 8 oy 12:00PM
Songbird "

16 Samual Fullerton 7 Cathy 12:30PM
Petterson

. Tanya )
17 Issac Spillman 5 St 1145AM
18 Chris Black 6 Mary Smith 12:00PM
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Precision Statement/Hypothesis

What

Where

When

Who

Why

What other info needed?

O O0Oo0oo

O Possible Solutions?

Precise Problem Statement &
Hypothesis Development

O Many students from all grade levels are engaging in
disruption, inappropriate language and harassment in
cafeteria and hallway during lunch, and the behavior
is maintained by peer attention

O A smaller number of students engage in skipping
and noncompliance/defiance in classes, (mostly in
rooms 13, 14 and 18), and these behaviors appear to
be maintained by escape.
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Solution Development

Prevention

Teaching

Reward

Extinction

Corrective Consequence

Data Collection

Solution Development:
For disruption in hall and cafeteria

Prevention *Teach behavioral expectations in
cafeteria

T hi *Maintain current lunch schedule,

caching but shift classes to balance numbers.

Reward Establish “Friday Five”: Extra 5 min
of lunch on Friday for five good
days.

Extinction Encourage all students to work for

“Friday Five”... make reward for
problem behavior less likely

Corrective Consequence Active supervision, and continued
early consequence (ODR)

Data Collection Maintain ODR record and
supervisor weekly report
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Langley Elementary
School

478 Students
K-5
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Precision Statement/Hypothesis

What

Where

When

Who

Why

What other info needed?

O0O0Oo0OoOoao

O Possible Solutions?
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Solution Development

Prevention

Teaching

Reward

Extinction

Corrective Consequence

Data Collection

Next Steps

0 High School Example

O Your School

O Individual Student Supports
O Planning for implementation

47
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Sandhill High school
354 students

Sandhill High School: 354 students
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—————————————
Sandhill High School

Sandhill High School
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Custom Report: Classroom

O Many students in many contexts... primarily
disrespect, and skipping.

Precision Statement/Hypothesis

O What
0O Where
O When
O
O
O

Who
Why
What other info needed?
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Grade Level Example

0 Mark Twain Elementary )
O Elliot Middle o
O Gorman High School )

Y our School e
)

O Use the Office Discipline Referral Summary

O Build from your SWIS data, or your best guess from
07-08

o Compute the national average for your school

o Elementary .35 per 100 per day

o Middle .92 per 100 per day

o High 1.06 per 100 per day

o K-(8orl2) 1.00 per 100 per day

o Enrollment /100 X (rate for your grade level)
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—————
Y our School

O Build your best guess about the patterns for:
= Location

= Time of day
= Type of problem behavior
|

What proportion of students have 0-1; 2-5; 6+
ODRs?

O Do we have a problem?
0 Can we define it with precision?

S
Y our School

Review Data

Do we have a problem?
Define problem with precision (or plan party)
Develop solution options

O O o o 0O

Define Action plan needed to implement
solution

2. PBIS #2 (Decision_making (ppt)) VI-58 p. 79



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 80 of 225

Solution Development

Prevention

Teaching

Reward

Extinction

Corrective Consequence

Data Collection

S
Y our School

O Use the solution model to build “possible
elements of a solution”
o Remember that you may have many that are
appropriate
o Identify many, then select the option(s) that are most
likely to be both effective and “doable” in your school

O Action Plan
o Who will do what when?
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z mmé; JCAZ(/J’.’

“PREDICTABLE
“*CONSISTENT
% POSITIVE
“*SAFE

—

How do we achieve this kind of school
culture?

T~
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+How do we achieve this kind of school
culture? (predictable, consistent, positive
and safe)

+What needs to happen? What would your
school look like?

+Choose one person to report back to the
group.

D

—

» 1. The PBIS framework is based on student
outcomes

» 2. Adoption of evidence and research-based
practices

» 3. Consistent with the response-to-
intervention

» 4. The effective, efficient, and relevant use of
data or information to guide decision-making

T~
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» Well, the USP says we need it! !!

» Seriously, the goal is to:
<*Reduce office referral rates
“»Improve attendance and school engagement
“*Improve academic achievement
“*Reduce dropout rates

“*Improve school climate
This list is your job description, but
buy in by the staff is a must. You
are not the PBIS person. You are
the leader, but everyone or at
least 80%

of the staff need to participate.

T~
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T~
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Using your white

board write
where you feel
most misbehavior
occurs during the
day.

\

SCHOOL-WIDE

1. Leadership team

2. Behavior purpose statement

3. Set of positive expectations & behaviors
4. Procedures for teaching classroom-wide
expected behavior

5. Continuum of procedures for
encouraging expected behavior

6. Continuum of procedures for
discouraging rule violations

7. Procedures for on-going data-based
monitoring & evaluation

T~
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CLASSROOM

1. All school-wide
2. Maximum structure & predictability in routines & environments

3. Positively stated expectations posted, taught, reviewed, prompted,
and supervised.

4. Opportunities to respond and do well academically

5. Continuum of strategies to acknowledge displays of appropriate
behavior.

6. Continuum of strategies for responding to inappropriate behavior.

INDIVIDUAL STUDENT

» 1.Behavioral competence at school & district levels
» 2.Function-based behavior support planning

» 3.Team-& data-based decision making

» 4.Comprehensive person-centered planning &
wraparound processes

» 5.Targeted social skills & self-management
instruction

» 6.Individualized instructional & curricular
accommodations
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NONCLASSROOM

» 1.Positive expectations & routines taught &
encouraged

» 2.Active supervision by all staff (Scan, move,
interact)

» 3.Precorrections & reminders

» 4.Positive reinforcement

—

FAMILY ENGAGEMENT
1. Continuum of positive behavior support for
all families

2. Frequent, regular positive contacts,
communications, & acknowledgements

3. Formal & active participation & involvement
as equal partner

4. Access to system of integrated school &
Community resources

T~
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\

You will want your expectations to be:

+No more than 5

«Keep it simple

« Positively stated

« Be specific

< Observable, Measurable

«Publicly Post in a prominent place (in other
words everywhere)

T~
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» SOMETHING THAT IS EASY TO CATCH ON TO
» SOMETHING THAT IS SCHOOL SPIRIT

» KEEP IT RATHER SHORT (4 OR 5) WORDS

» SCHOOL LOGO

» NAME OF SCHOOL (IF IT IS SHORT)

» SOMETHING THAT ALL AGES UNDERSTAND

—

Go to the white paper on the wall and write
down rewards for positive behavior

Be creative
Be aensitive Lo what students would enjoy

Re fun

T~
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THANK YOU SO
MUCH FOR A
LOVELY CLASS

—

10
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Home | Contact Us | Login

PBIS Resource Center | Teacher Resource Center | Bullying Resource Center | About Dr. Eric

Data Collection

What type of data does a school need to collect?

Most schools collect and record office discipline referrals (ODRs). These are
instances of behaviors that require immediate administrative attention. This
type of data is important to document major incidents in schools, as well as

required for more intensive behaviors.

However, if schools are not systematically collecting and summarizing data for
chronic low level behaviors that result in disciplinary actions other
administrative attention, the everyday needs of students and behaviors that
frustrate teachers are not being addressed. These can be collected through
Minor Incident Reports (MIRs). An MIR is simply a point of data that
indicates that a teacher had to stop and discipline a student beyond normal
prompts and verbal correction, such as assigning a detention, making an
environmental change, or contacting a parent.

Click here to read how MIRs work in a discipline plan

Click here for MIR printing proof and how to use them in schools.

Teacher Resource Center PBIS Resource Center Bullying Resource Center

The Teacher Resource Center at My- School-wide positive behavior interventions The complex nature of bullying demands
Behavior-Resource.com is designed to provide and supports (PBIS) is a systemic framework interventions that are more multifaceted than
teachers with professional development topics for addressing challenging behaviors within a simple "anti-bullying" sign posted in the

to address current behavioral issues in public schools. More.. hallways or assigning bullies to an alternative
schools. More.. school. More..

www.mybehaviorresource.com

Copyright © 2003-2011
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Referrer
Student Name Grade Gender Ethnicity (e.g. teacher, monitor, etc) Infraction  Location Date Time Consequence
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GRADE
Code Kinder 1 2 3 4 5 6 7 8
Name Kinder 1st Grade 2nd Grade 3rd Grade 4th Grade 5th Grade 6th Grade 7th Grade 8th Grade
Total 0 0 0 0 0 0 0 0 0
1
0.9
0.8
0.7
0.6
0.5
0.4 .
03 M Seriesl
0.2
0.1
0 T T T T T T T T T T T ,
@Qb'z" 6'666 6@6@ o@t’z o@be (9@3’6 6@6@ G'bbz 0@&’/ dbée 6@6 (9@& @be
R I A S S S~
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GENDER

Code

Male

Female

Name

Male

Female

Total

0

0

0.9
0.8
0.7
0.6
0.5
0.4
0.3
0.2
0.1

M Seriesl

Male Female
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Ethnicity

Code LA AA AS AN NA Pl MU ELL ExEd

Name Latino African Am. Asian Anglo Native Am | Pacific Island MULTI ELL Ex Ed

Total 0 0 0 0 0 0 0 0 0

0.9
0.8
0.7
0.6

0.5
0.4 B Seriesl

0.3
0.2
0.1

0 T T T )
Latino African Asian Anglo Native Pacific MULTI ELL  ExEd
Am. Am  Island
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Referrer
Code R1 R2 R3 R4 R5 R6
Name insert name insert name insert name insert name insert name insert name
Total 0 0 0 0 0 0
1
0.9
0.8
0.7
0.6
0.5
0.4 M Seriesl
0.3
0.2
0.1
0 T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T 1
insertinsertinsertinsertinsertinsertinsertinsertinsertinsertinsertinsertinsertinsertinsertinsert
namenamenamenamenamenamenamenamenamenamenamenamenamenamenamename
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INFRACTION

Code 11 12 13 14 15
Name insert infraction insert infraction insert infraction insert infraction insert infraction
Total 0 0 0 0 0

1

0.9

0.8

0.7

0.6

0.5

0.4

0.3 m Series1

0.2

0.1

0 T T T T T T T T T T T T T T T

C 0 L L L L LN
SIS S S I T S S RS S S N S S

A . S S e S S S S U S SR S S S

C &l @ @ @ @ @ L@ @ @ @«

RTINS NN N NS NN NS

&L PO S S G O ) S &

L L L L L L L L L L L L L L £
RN NN N NN N N NN
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LOCATION
Code L1 L2 L3 L4 L5 L6 L7
insert insert insert insert insert insert insert
Name location location location location location location location
Total 0 0 0 0 0 0 0
1
0.9
0.8
0.7
0.6
0.5
0.4 B Seriesl
0.3
0.2
0.1
0 T T T T T T T T T T T T T T T )
. \(\%Q’i\%@i@@i{a"i\é”i@&.;@"5&.;ga"’é.;(&"’é.;@‘”é.;Q\%"’Q&.;(\%“{&.;(\%&;(\%&@%‘?}z\%@é
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TIME
Code BS AS LU PO P1 P2
Before After insert insert insert
Name School School Lunch class class class
Total 0 0 0 0 0 0
1
0.9
0.8
0.7
0.6
0.5
0.4 M Seriesl
0.3
0.2
0.1
0 T T . . T T T T )
Q)é\o&. v%& é.\,é\ '\Q% Q}& \09 Q}\’. \(\c,eé '\Q% Q}n \(\(’ Q}& \Q{’ Q}V \9{9@(\," \Q‘Q Q}&.
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CONSEQUENCE

Code

C1l

C2

C3

C4

C5

C6

C7

C8

Name

Insert
consequence

Insert
consequence

Insert
consequence

Insert
consequence

Insert
consequence

Insert
consequence

Insert
consequence

Insert
consequence

Total

0

0

0

0

0

0

0

0
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PBIS Data Management using Excel

This handout will look at the different data that can be pulled from the
PBIS template for MS Excel. Topics covered include data entry, graphs,
multiple workbooks, formulas, reports, filtering, and others.

The template is customizable so that each individual building and district,
with just a little editing, may use it. Codes are created by the user, the
number depending on need. They may be simple (I1, I2, ..) or more complex
by using whole words and phrases.

PAGE 1 --- Main Date Entry.

B Eie Edit Yiew Insert Format ools Data Window Help ;IQILI‘
IDedeky|(seads o |(@= &8 3 |md o @
|tmestienraman Sz H|B £ D == =E|% % , fﬁgs?ﬁ‘§;§§.§|aﬂ'é'é'.|
D15 | =]

[ A T e T e ] D = T T I =S
3 |Student Name ‘Gsndsr ‘G‘rade |Refamng Teacher |Infram:lon|LoEamon ‘Dats |T1me ‘Consﬁquen[:ﬁ ‘ =
| 4 |Alan Scott ity 10 Allen I1 L3 12/1/8% B3 C1 m
| & |Ted Grant M 12 Tordan 12 L5 12/9/85 |AS cz
| 6 DinahLance F 12 Tones i3 L7 12/10/9% LU C5
| 7 |Jay Garricl ity 11 Raymend I5 L4 12/10/%% |1 C3
| 8 Joan Garrickk  F = Palmer 16 L& 12/10/9% |2 Cé
| 9 Rex Tyler M 1 Allen 11z Lz 1211258 |4 [o%:]
| 10 | Alan Scott ity 3 Jordan 4 L4 1211395 |7 C5
| 11| Alan Scott M 8 Palmer I13 Lé 1211598 |5 C3
[ 12| Ted Grant M 9 Allen Il L1o 12/16/%3 BS c7
| 13 | Al Pratt ity 12 Jordan 16 L13 12/17/8% |AS C3
|14 Dinah Lance  F 2 Palmer I8 Lz 1211898 |2 C5
|15 ity 11 I3 L14 12/1%/% LU C7
16 F 1 | _IH(S L12 1/12/00 |2 Cé
17 M 4 116 L1z 1/15/00 |4 4
| 18 F 1 116 L4 1/15/00 |5 C3
|19 F 11 114 L5 1116/00 |6 cz2
|20 M 1 118 Lz 1/21/00 |7 C5
21 ity 12 113 L1 1/24/00 |2 C4

3 2

|22 11 L5 1425000 53]

| on ! hd
14 [ 4P Main Data Jhinfraction [ Location f Time f Consequence /£ Grade / Gender  Datafor Gra |4 | 1l
Ready [ \ [0 o —
fig 1.1

The main entry sheet is a straightforward data entry sheet. In this
example, it is filled with some junk data as an example. Across the top row
of the spreadsheet are the various types of data we are tracking, (gender,
grade, infractions, etc..) and the data then goes across the rows on down.
Excel can handle 65536 rows, so don't worry about running out of space.

The codes used are created solely based on the need of the user. For
example, under the Location column in the picture above, the codes L1, L2,
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Codes do not
have to bein
the format of
L1, C1and so
on; they can
be whole
words or
names. Just
remember that
they must be
entered
exactly the
same each
time.

friendly way.

Last PAGE --- Data For Graph

ROE 02

Greg Dorsey & Candi Hayward

L3 through L15 are used. And as seen by the list in appendix A,
these codes represent places such as Lunch Room, Gym, Hallway,
and so on. Also, the tracking is in no way limited to a certain
number of codes per topic, other than the fact if too many are
used, the legends on the graphs are harder to print in a reader

The data for graph page is very important for the graphing. The reason
being that when the separate pages are used for each report, the data is
broken over many lines and Excel is unable to graph anything but a straight
line of data, either across or down (in versions older than Office 2000).

£ Microsoft Excel - data HE B3
&) Ble Edit Wew Insert Format ook Data Window Help — & x|

DEE s8Ry |[smad oo [az 48 ns e 5.

| Times Hew Roman =10 = ‘ B I U |§

Bls%, 9o == m- oA

PR [
A [ B e 7 D [EE F [ G [ HE
1 =
2 1
| 3 [Gym [Classroom [Flayground [Cafeteria [Haliwa [Parking Lot [Lower Pasting |Library
| 4] 1 3 2 3 3 1 2
15
B
7 |Tardy Language Repeated MinjDefiance Disruption | Skip Class Harassment Fighting
I 3 2 1 T T 3
12
10
11 |Before Schoal |15t Perind |2nd Period  [3rd Ferind [4th Perind_ [Lunch [5th Feriod [6th Perind
[12] ] 1 5 7 7 1 7
13
14 |Lunch Detention ‘A&er School ]jMeet with PaJReferral ‘3 Day Susp‘ 10 Day SuspenJIﬂ—House Susp&{Expulswn
| 15| 2 4 5 2 5 4 4
16
17 | Male ‘Female |
|18 | 17 12
19
20 |Kindergarten |15t Grade [ndGrads  [3rd Crade [4th Grade  [5th Grads [6th Grade [7th Grads
| 21| 2 4 1 B 1 2 1 -
144 [» [m{ Infraction # Location £ Time 4 Consequence / Grade f Gender ’Data for Graph (B | ﬂj_‘
Ready [ [ [ o 0

fig1.2

In the picture above, each piece of data that is to be graphed is laid out in a
solid line. This data will need to be placed in the report view, shown below.
This is done by copying the formulas from the Data for Graph page to the
sheet it belongs on, in this case the location sheet.
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E3 Microsoft Excel - data [_[=]x]
J File Edit Wiew Insett Format Tools Data MWindow Help .= 5[‘
IDZH SRy BRI o - &z s tlil = -3
| aia =B IU[SE=E 8%, B4 B -H-A-.
Al = =| Infractions by Location
A | B [ © [ ®© [ E [ F [ & [ w® ] T [ J [ E [ L [ M M [ o | F | @& R s —
Infractions by Location [
1
2
| 5o | Playgroun | Careten |Hallvay | Parking | Lower | Library
( d Lot | Parking
1 S | = [ s [ s [ v [ =z [z
| 5]
| & |
7
CDmpuLE| e | Eand | Fiest ‘Locker| Ball ‘ Dther
8 | rlab Foom | Room | Room | Field
B v | 3 [ o [ 3 [ 1] 1 ] o |
|10
11
|2 |
e Locations
s | T
| s B Classroom
% 0 Flayground
T O Cafeteria
20| W Hallway
| 21| o Farking Lot
[ == | B Lower Parking
|23 O Library
|2 m Computer Lab
25 .
? | Office
ez | 0 Eand Foom
|28 | O Rest Room
| 22| m Lacker Foom
| o 1 m Ell Field -
% B Other =
14 [ 4 [» [wil{ Infraction s Location { Time £ Consequence f Grade £ Gender £ Data for Graph / |<| | ﬂ

Ready

fig 1.3
A Look at Formulas

| B Y | B B

The formula that all of the data is collected from is virtually the same for
each time, with only a minor change for each. The basic formula look likes
=COUNTTIF('Main Data'l$column$first row:$column$last row,"Code")

For the location formula above the gym (circled in example above fig 1.3)
would be =COUNTIF('Main Data'!$F$4:$F$300,"L1"). Now look at that a
little more closely...

3. PBIS #3 (DataManagementUsingExcel (pdf))

= COUNTTIF | (Main Data’l | $F$4 : $F$300 ,"L1")
The The Main Data refers | The F and | The Same as $F$4 | ThelLl
equal COUNTIF to the main data | 4 are the | Colonis | only represents
sign formula will sheet that the column always | representing what the
always count the equation is and row used as | the end of the | formulais
starts a | number of calculating from. | identifiers | a break | range. This counting; in
equation | times a This is not need | that show | between | number cango | this case L1
certain item | if the calculation | where the | the up to 65536 so | represents
appears ina is done on the formula start there is plenty | the
given range. same work sheet. | range and room. occurrences
start. finish of
The dollar | of a Infractions
<$> states | range. that take
that the place in the
equation Gym.
will always
point to
these
cells.
4
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Gym Classroom Playground | Cafeteria | Hallway | Parking Lower Library
Lot Parking
1 5 2 3 3 1 2 2

3. PBIS #3 (DataManagementUsingExcel (pdf))

In the section above, taken from the location page, the equations are in the
format above. Each one is exactly the same except for the code that it is
counting. The gym uses the formula

=COUNTIF('Main Data'!$F$4:$F$300,"L1")  While the classroom uses
=COUNTIF('Main Data'l$F$4:$F$300,'L2") The playground would use "L3",
the Cafeteria "L4" and so on.

Setting Up the Formulas in Each Sheet

To set up the formulas for the calculations, go to the Data for Graph sheet.
It will be easier to keep track of the formulas if all of the computations are
done in one place. Create a list going across with the first list of data that
is being charted. Again using the location numbers it would look something
like this.

A | & | ¢ | b | E | F ]

[Classroom |P1&5rgru:uund |Cafeteria |Ha]lwa;r |Pa.rk:ing Lot |

6 3 2 3 3 1

Next set up the initial formula, which should be the first item, in this case,
6ym. As seen above, the formula for gym would be
=COUNTIF('Main Data'l$F$4:$F$300,"L1")

_T“I-h-l'_n_'lf\_'l|—'~

After setting up the initial formula, it can be copied to the remaining cells
by using the drag command.

1. Place the cursor on the bottom right corner of the cell with formula
in it. In this case A4. (Circled above) The cursor will change from
the "3-D" plus to a simple plus (+).

2. Click and hold down the mouse button and move the mouse over to
highlight the entire row that the formula is to be copied info. (See
below).
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n | = | L l U | c | r | 1
1
2|
3 |Crm Classroom |P1a',.rgmund |Cafeteria |Ha]1wa',.r |Pa.rldns=rLu:ut |anerPaﬂdns=
4 1 5 2 3 3 *
= DASHED LINE
3. Once the entire row that the formula is going into is highlighted (as

shown with the dashed line) release the mouse button.

4. All of the newly filled cells will be the same as the first. In this case
the 1 that is under GYM. Move to the next cell under CLASSROOM
(Cell B4). In the formula bar, change the L1 to L2 leaving the rest of
the formula alone.

5. Do this for each of the cells, changing only the Code (L1, L2,..) in
each to correspond with the header in ROW 3 that each code
reflects.

6. Repeat this for each Column in the MAIN DATA page that has data
to track. (Time, Infraction, Consequence, etc...)

*** Remember that these numbers can always be changed, added or

subtracted later.

Setting up Individual Report Sheets

To create the individual data sheets, choose insert from the top menu bar,
and then choose worksheet. This will insert a blank worksheet in the
spreadsheet. Rename it by choosing Format - Sheet > Rename. Name it
for whichever information that will be reported on in that page, as below.

" Infraction £ Lacation £ Time £ Cansequence f Grade f Gender »Data for Graph /|
| ]

Copy the information from the Data for Graph sheet to the new sheet
created by highlighting the cells to be copied, choosing copy from the Edit
menu, move to the new worksheet by clicking on the sheets name, put the
cursor where the cells should be pasted to, and choose Edit > Paste.

Report Sheets - in Depth

After covering the basics of the formulas, this next session will look at the
individual parts of the report sheets, such as the formatting and the graphs,
and how to create and manipulate each of those pieces.
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050 e ata ~|Fx
J File Edit W%ew Insert Formak Tools Daka Window Help P = |ﬁ'|5|
DE[gRYsmado-o (o= siii@p o~ -2
JTimesNewRoman v 12 v|BIH|§|§E|$%, ngm‘;?’;?lﬁ'&vév,
Ad =] =| =COUNTIF {Main Data'$CH4: §C$300,"k")
A | 8 [ ¢ | o [ E [ F [ &6 [ H [ 1 [ 4 [T
5 ]
3 Kindergarten 15t Grade | ZndGrade | 3rd Grade Ath Grade 5thGrade | 6th Grade |Tth Grade
4 2 4 1 2 1 2 1 2
5)
B 8th Grade Sth Grade | 10th Grade | 11th Grade | 13th Grade
7 2 5 3 4 6
N
N .
| 10| 7 E Kindergarten
miN W 15t Grade
= 6 0 2nd Grad
13 n rade
e Flot Area
| 14 5 Pt vea O 3rd Grade
15
KA W 4th Grade
17 | 4 @ 5th Grade
15
Kl 3 W 6th Grade
a0 5 0 7th Grade
% m 5th Grade
BEl 1 — | 9th Grade
| 24 | 0 o 10th Grade -
e @ 11th Grade
| 25 | 9 o =
|4 [4]» [M[ MainData £ Infraction £ Location £ Time £ Consequence hGrade ; Gender 7 Datafar Gra |4 | | LIJJ

Ready

1 | B B V77 I ]

When setting up the individual report sheets, the first step is to copy the
formulas from the Data for Graph page.

1.

w

Go to the Data for Graph Sheet by clicking on the sheet's title
along the bottom of the page.

. Click on the first cell of the range to be copied and hold the mouse

button down. Move the mouse to the last cell in the range and
release the button. In this instance, the range would be the yellow
row with the titles and the next row with the formulas.

From the top menu bar, choose Edit > Copy.

Move back to the report sheet that the data is going into, by
clicking on its title on the bottom of the page.

Place the cursor in the cell that the data is to be copied into. In
the example above, cell A3 is the first cell in the range. Choose
Edit > Paste.

Using the Cut command, move the cells so that they are on multiple
rows if needed, as in the example above, where the gh grade data
starts on a new row.

Next we need to graph the data. This is done using the Chart Wizard
(circled above).

3. PBIS #3 (DataManagementUsingExcel (pdf))
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7. Click on the Chart Wizard button on the menu bar.

Choose the type of Graph needed. Column sometimes works best

with large amounts of Data, but any of the choices may be made.

Click Next.

9. Next, enter the data range. To do this, click on the small button
at the end of the range box. The screen will go back to the
spreadsheet. Click on Data for Graph: highlight the range to be
graphed in the same method as the copying above. Click on the
small button again. This will lead back to the graph wizard.

10. From the Series In option, choose whether the graph data is in
columns or rows. In this example, choose Columns. Click Next.

11. Title the Chart if desired, then click Next, then Finish. The graph
will pop up the work sheet. Move the graph to the position desired.

12. Repeat this for each report sheet.

oo

Tracking Data Monthly & Over Time

Data of this type can be informative both over a longer period of time like a
semester or school year, or shorter amounts of time, like a month. The
simplest way fo do this is to ftrack all the data on one long running sheet,
then at the end of the month, copy that months data fo a new sheet. To do
this, first create a blank template of the sheet for future uses.

1. Go to the Main Data sheet. Highlight all of the data in the sheet,

except the column headers and hit the delete key.
2. Go to the top menu bar, and choose File > Save As....

F Microsoft Excel - data

=7 File Edit Wie rmat Tools Data Window Help ;Iilill
Dlﬁ‘vn|§ A—X\hﬁ‘§|nvm ‘g,zf;.AJ,AJ,|ﬂ.@1nD/

Times Mevw Roman /v H = < a0 i= =

3 |Ge A =+ @@ % o B - oroos e
| 4 M 1 =
| 5 1o 12

6 |F 1z

7 |2 1

e ¥ k

ERY 1

RENEYS 3

EEREY: 8

12 1 E

EEREYS 1z

| 14 F 2

|15 |11 11

16 |F 1

|17 ot 4 LI & save I

|18 F 1 I tback = =

|19 F 1T =

| 20 |10 1

|21 21 12 ik

22 ML 3 TIMicrosol Ft Excel 5.0/95 workbook hd

\4|4T}’|b|!\Mair; Data ¢ Infraction £ Location ;(Ti:ne Fd Cnnseg eeeee A ar ade /£ Gender £ Data fol mers [ER] |>||_I
e [ | R
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3. In the Save as Type (circled) choose Template. Under Save In,
Change to the Spreadsheet Solutions folder on the hardrive,
usually in Microsoft Office > Templates.

4. Name the file, and hit the Save Button.

Now that a blank template is created, the monthly sheets can be done.

5. Choose File > New. Click on the Spreadsheet Solutions tab.
Choose the file created in the steps above.

6. Open the main tracking document. Sort by date.

o Click on the first cell in the header row, in the examples
above, cell A3 (Student Name)

o From the Top Menu Bar, choose Data > Sort.

0 In the window that pops up, choose sort by Date. Click
Ok.

7. Go to the first day of entry for the month to be pulled out. For
example, if pulling out the December data, move to the row that
might contain 12/1/99.

8. Click on the Row Number that has the first entry for the month.
Holding down the button, move the mouse down till all of the rows
for that month are highlighted.

£4 Microsoft Excel - data
[H7 File Edit Yiew Insert Format Tools Data Window Help — & ]

DEH ey faas
Tirnes Mew Roman - 12 -|B R ‘%
Al ~ = Alan Scott
[ A

3 [Student Hajne
7
dent 1TAWe | Gender  |Grade  |Referring Teacher |Infraction |Location |Date | Titne [Consequence
% ott 14 10 Allen 11 13 12/1/92 BS 1
Ty Grant 14 12 Tordan 1z L5 1219199  AS <2
M Dickh Lance  F 12 Tenes i3 L7 12/10/98 LU 5
(Tay farrick ¥ 11 Raymond 15 14 12/10/29 1 [eX]
Mool Garricle  F L Palmer 16 12 12710725 2 <6
M R =g Tler 14 1 Allen 112 12 12112499 4 [ol:]
1|l Scott I4 3 Tordan 4 L4 12113499 7 5
|41l Scott ¥ 8 Palmer 113 16 12/15/99 5 [eX]
Ted Grant 14 3 Allen 11 10 12716199 BS o7
|41 fPratt 14 12 TJordan 15 113 12117499 AS 3
Diffah Lance  F z Palmy b=} Lz 1218499 2 5
¥ 11 1% 114 12/19/99 11T o7
| N F 1 116 11z 1/12/00 |2 6
|17 | I 4 Il L1z 1415700 |4 =21
18] F 1 116 14 1/15/00 |5 <3
19 F 11 114 Ls 1/16/00 | <2
14 | 4[> [#1*Main Data  Infraction 4 Location £ Time /£ Consequence / Grade A Gender £ Data For Gra |4 r o 1 Llj_l
Ready | sum=43sizo [ [ mMuml [

9. Choose Edit > Copy. Switch to the new blank document.
10.Click in the cell where the first line of data is to go, A4 in the
example above. Choose Edit > Paste
11. Do a File > Save As.. and name the file, in this case, December.
Click Save.
Repeat this at the end of each month. That way there will be a running total
and a monthly total. This can also be done for any amount of time, or to
track any one piece of information, not just dates.
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Filtering Data

In some instances, data may be filtered to look at a certain piece of
information, such as one particular student's infractions, the number of a
certain infraction, referrals from a particular teacher, the number of
infractions that happen in a given location, and so on. Filtering can do this.
To Filter:
1. As in the sorting example above, in the Main Data sheet, click on
the first cell of the title row (A3, Student name).
2. From the top menu bar, choose Data > Filter > Auto Filter.
3. This will place little arrows on each of the items. These drop down
arrows will give all of the items in that column as choices.

Student Marne » iGenderLi Grade LiRefem'ng Teachd?iln&acticliLocatioLiDate LiTime L‘ Consequencli
Aan Scott M 10 L3 12/1/9% EBS C1
Ted Grant M 12 {Custom...) L5 12/5/99 A3 cz
Dinah Lance  F 12 Allen i L7 12010/99 LU 5
Tay Garrick M 11 14 12110/99 1 C3
Joan Garrick  |F k L8 12110/9% 2 Cé
Rex Tyler M 1 L2 12112/9% 4 8

4. Click on the arrow of the topic to filter by, and choose the
criteria. In this example, clicking on Jordan would give only the
rows that Jordan was the referring teacher. Data can be filtered
by more than one category by choosing the first criteria, and then
by choosing a second from what that leaves and so on.

5. Once the data has been properly filtered, copy the data to a blank
template as in the example above. That information is now
graphed in a new sheet. Filtering in a document does not affect
the graphs in that document. The new information must be
copied to a new sheet for the data to be graphed alone.
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Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 111 of 225

Tucson Dinner Theater % School Safety

Arizona's Oldest & Longest Running Mystery Dinner Theater. Contact
e Download "10 Steps Toward A Safer Campus" From TycolS

Welcome to PBIS World! Click on a Behavior to Start:

Aggressive and/or Bullying Anxiety Confrontational/Defensive Defiant
Disorganized Disrespectful Disruptive Failing To Turn In Work
Frustration Hyperactivity Impulsive Inappropriate Language
Lack of Participation Lack of Responsibility Lack of Social Skills Low/No Work Completion
Lying/Cheating Name Calling Negative Attitude Off-Task Disruptive
Off-Task Non-Disruptive Out of Seat Poor Coping Skills Poor Peer Relationships
Poor Self Esteem Rushing Through Work Sadness/Depression Somatic Complaints
Stealing Tantrums/Out of Control Tardiness Unable to Work Independently

Unfocused/Inattentive Unmotivated Upset/Crying Other

SEARCH PBIS WORLD SupPPER SLEUTHS MYSTERY PBIS WorLD REcOMMENDS

Bring your HS drama club or student org
together with one of these great games!

THE PBIS WORLD BOOK!

NoTice
PBIS World is in no way affiliated, associated, or
connected with any other website, entity,
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)

AN\
Data Collection &
Progress Monitoring
for Behaviors

Betsy Stanwood /
\/\/-\/ 4

Fall 2007
Revised July 2010

First...

A basic understanding of Positive
Behavioral Interventions and
Supports and How it fits with
Problem Solving Model

Af_a'

J
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What is
“Positive Behavioral

Support”?
PBIS focuses on PROACTIVE support
strategies that

e reduce the likelihood of problem
behavior

e allow individual students to be as
independent and successful as
possible in the school setting.

e encompass a range of strategies
from systemic to individual supports

M Intensi
PBIS Continuum Inferventions -
individualized
strategies
students with high
risk behaviors

Universal Interventions -
proactive strategies

supporting all students Targeted Interventions -

specialized strategies
supporting students with
at risk behaviors
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Positive Behavioral Interventions & Supports

! I |

Intensive

= School-wide PBIS « PSM Team / IAP / TEP  "PSM Team / IAP / IEP
- System wide procedures -PSM Interventions -Formal evaluation
- School wide systems -IAP or IEP -Functional Behavior
- lC\lIussrloom systems -Functional Behavior Assessment
- Non classroom systems Assessment -Behavior Intervention Plan
*- Proactive management -Behavior Intervention Plan s\é\gg;‘tnelsnm%%n
ideas 'E:*;‘S‘r::”:fm“' -Short-Term Suspension
- Informal/formal data assessment, A ;
: nalysis ksheet
collection and evaluation observation alysis Workshee
= Mental Health in the
Schools

Problem Solving Continuum
) — IN"II'E_N_,S(I’ZE
<Z—3 STRATEGIC

5-15%
CORE
80 -90 %

(S
_bo
&
&
<
N
(o)
(7]
~
L
(/]
~

School-wide systems to support student achievement.

Adapted from Sugai and Horner
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How Do the Processes Align?

The most imror'fan'r alignment is that both support
most students through ™universal” school/classroom
processes, some students through more “targeted”
support, and a small group with"the most “intensive”
support -
Other Areas of Alignment Include:

Baseline data collection ——
Analysis of data collected e —
Problem definition _—
Design interventions ——pR———

Identification of who, when, where teaching will occur

Implementation of interventions

Charting/Progress Monitoring

Analysis of progress

Continue implementation, change the interventions some, change the interventions
significantly

Continue with the review plan, intervene, analyze process

Based in Behavior Analysis

Data Collection

Collecting Data in Many Ways to
Assist in the Development of
Intervention Strategies
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Why do you need to
collect data?

* to implement best teaching practices

+ to report progress to parents

* to collect information regarding a student;
or students’ performance

le

* to address the I.D.E.A. "Special Factors”
requirement for a student with an IEP

* to monitor a behavior or the response to an
intervention directed towards the behavior

- to determine eligibility for accommodations
or educational services

Ways to Collect Data . . .
Informal
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Basic Conduct Chart \

NAME: DATES: TO.
SCHEDULE BEHAVIOR BEHAVIOR BEHAVIOR BONUS STEPS/HOME
#1 #2 #3 POINTS WORK/OR

AGENDA

TEACHER COMMENTS:

PARENT COMMENTS:

From “Practical Charts for
Managing Behaviors” by Lynn
Lanvelle

Time Increments Chart \

Student Name Date
BEHAVIOR [ 730 [ 800 | 830 [ 900 [930 [1000 [ 1030 [ 1100 f11:30 [ 1200 | 1230 | noo [ 130 [ 200 [ 230 [ coi

Each Mark = 1 Point

Morning Points - Afternoon Points -
From “Practical

Parent Signature Charts for Managing
Behaviors” by Lynn
Lanvelle
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Ways to Collect Data . . .
Formal

Start time: 8:05 End time: 9:00 Setting: Seventh-grade math class
Definition of behavior: Talking out is defined as any noise that is made
without first raising hand in appropriate manner and waiting for permission
to speak.

Observer: Carol Burke (math teacher)

Student Mon. Tues. Wed. Thurs. Fri.
Name 3/2/98 3/3/98 3/4/98 3/5/98 3/6/98
Sammy 1] 11] 1] 1] Il
Karen | | Il 1] |
Chris 1] Ml 1] 1] 1]

Key: Each tick mark represents one talk-out.

) Sample Event Record

Ways to Collect Data . . .
Formal \

Start time: 8:05 End time: 8:15 Setting: seventh-grade English class
Definition of behavior: On-task behavior is defined as appropriately writing, reading,
talking about the assignment, or waiting to ask the teacher a question regarding the
assignment.

Observer: Daffy Duck (recess monitor)

minute

o|x|o|x|o|o|x|x|x|o|g

x|o|x|o|x|o|x|olo|o|8

Blo|o|~|o|o|s|w|n |-

x|o|x|o|x|x|x|o|o|x|8
olo|x|o|x|olo|x|o[x|&
x|x|x|o|x|x|o|o|x|x|3
o|x|o|o|x|o|x|x|o|0[8

Key: O = Behavior was not observed at all during the 10-second interval.
X = Behavior was observed at least once during the 10-second interval.
‘_ 10” = 10 seconds.

Sample Interval Recording
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lection

Student: +~it observed or useYiN
Teacher/Subject:

Date:

Time: _— —

Activity:

Comments:

~Tool Provided by Suzanne Rilling

Sample Completed
Collection Too

Data
I

. 1~ It abserved or useYiN
Teacher/Subject:

-Tool Provided by Suzanne Rilling

Date: 10 (5107 @;.;«-;g‘wf,fv
Time: 122235 - '35 L(v”r« pgsf" _ |Activity: Comments:
DI ""5'4‘ x e T \M‘F - -
|25 - 24| @I ritiis —Cadting * me. 1o tiace”
f Denjo. —> Al n - ] .ﬂriu__%__ - _1%;?;?;‘.6\]53”%\?:
B ] S o lmaasdea T Lond Lo cha'oe
- Spinning
5 . —
s )@ DD fotny e sk megionny
AR - =)
{ 1255 - (05 | ,u‘LJ_\L 2N [ N
) ;
[Los- 1o 1M1 @ )] .
| _ |Swidch azrmé st o
-z 9 oy @ w:ﬂ«sr‘;ﬁ; Shevirs Ak d
- P . m l@"‘ = r\a(» cm\.\cA en 4—6
rzo— vas Ml u @ o @ o e o ST e
- Pt e e ks
e | @D G | ke
B H—Go.i :‘Jur‘\
~Told pa-+nu—+c

Shutoe
CFRes=i~n  Pactnesc

3. PBIS #3 (Data Collection and Progress Monitoring for Behaviors

(ppt) VI-58 p. 120



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 121 of 225

Example Format
for Data Collection

FREQUENCY DATA SHEET
Student: ___ Teacher: __
Date | Time Location/Activity Presence of Others, Adult Other Factors

Behavior of b
Concern Exhibited Peers, Adult(Specify) Response/Action

Behavior:

Tallies:

@9 NHCS PBIS 3 Tool

And Now What?

Intervention

and

Evaluation
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Organize and Summarize
- Record behaviors that can be seen and measured

* Collect information across time and settings

+ Utilize multiple observers, if possible

- Utilize data collection tools
Be Specific
Be Concise

" Be Descriptive
§.7 Just the facts!

=
Analyze the Data ®

* Are there patterns?

+ Are there specific locations,times, subjects or people?
(Triggers)

* Are there physical signals of impending problems?

+ Are there home concerns? Divorce? Death? Illness?
Transition?

How often do the behaviors occur? (frequency)
How long do behaviors last? (duration)
How severe or damaging are the behaviors? (intensity)

* Can the student continue with their school day when
behavioral episode is over?
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Example Format
for Data Analysis

Frequency
(How often occurs per
hour, day week)

Intensity
(How damaging or
destructive: mild,
moderate, severe)

Duration
(How long lasts: minutes,
hours

Behaviors
Of Concern
(What student does)

u“v

NHCS PBIS 4 Tool

Intervention and Evaluation

+ Change aspects of the environment that trigger
challenging behavior

. Teach the student more acceptable ways to get their
needs met

* Change aspects of the environment that happen
following the behavior

* Collect data and evaluate impact of interventions on

behavior

, T 2
L .--'ld'.l-'"- "-n-lf_‘
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Research

What We Should Know About
Behaviors

What Does the
Research Tell Us?

George Batsche

Professor of Psychological and Social Foundations
Coordinator of 6raduate Programs in School
Psychology @ USF (University of South Florida)
College of Education

Specialty: Bullying, adolescent depression,
aggression, violence prevention. Batsche has

been on NBC Today, Oprah Winfrey and 20/20
on bullying, aggression and violence prevention.
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Focus on Tiers (Levels)

I &II as
General Education Requirement

Tier I

- Data on Office & Discipline referrals and Actions that
took place

*+ School wide Positive Behavioral Interventions and
Supports

+ Second Step

Tier IT
- Direct behavior training (social skills)

*+ Additional ’rr-aininfg or groups (self-instruction, anger
control, organizafional skills)

+ Development of Programs in the school to address top
areas of need

~
~ : 9‘ -George Batsche
N

|

Focus of Tier (Level) III
as More Formal Process

Team Meets & Typically begins

- Formal Collection of data (Frequency
data)

- Completion of Functional Behavioral
Assessment (FBA)

- Design of a Behavioral Intervention
Plan (BIP)

- Implementation of BIP
- Progress Monitoring

=
@ -George Batsche
A

J
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What about Progress Monitoring
& Peer Comparisons?

Level of Behavior “"necessary for success”
versus Level of Current, Local Peer

Performance
Level of Behavior Level of Current, Local
Necessary for Success Peer Performance

(Proficient Level)

l l

*75% for Peer could be as high as 90%
+On Task but this is more than proficient.
Compliant National Standard (NCLB) is

=\ __ Accuracy of Work proficient.

@ -George Batsche
N

But What About the
Most Severe Behaviors?

- Harmful to self or others: Assault
and battery

* Not Harmful to self or others but
causes significant disruption of the
learning environment.

Target for replacement behavior would need
fo be higher than the 75% proficient level

!

100% would need to be
the target level for
replacement behavior
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What Are We Doing?

What We Are Doing With Behaviors

What Have We Been
Doing?

Progress monitored by observing student at least 3 times
a week

Remembered that we needed to progress monitor
academic areas that were impacted by the behavior
Charted results of our behavior observations and our
academic probes

Utilized same decision making strategies regarding
changing the interventions as we would with an academic
only issue

Remembered that students who have behavioral

issues but have no educational impact would continue
at PSM intervention level but would not be eligible for
consideration for entitlement.

15
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What Criteria Have We
Used?

- Student must meet all of the criteria
set despite intervention at grade level
and a minimum of three changes in the
hypotheses and strategies per skill area.

* Criteria can be met using

- progress monitoring in one academic area and
one behavioral area OR

- in two behavioral areas.

49‘

|

NHCS Behavior

Criteria

« Student must meet all of the criteria
indicated despite

- intervention at grade level

- a minimum of 3 changes in hypoteses &
strategies per skill area

* Criteria can be met using progress
monitoring in

* 1 academic area & 1 behavior area OR

+ 2 behavior areas

Af_a'

J

16
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NHCS Behavior Criteria

4 Criteria Areas

1. Performance well below peers as evidence
by performance below goal(s) set below.

a) Replacement behavior goal set @ 100% for behavior that

i. Is or may be harmful to self and/or others. EXAMPLES INCLUDE
BUT ARE NOT LIMITED TO

Assault (any act of such nature to excite an apprehension of a
harmful or offensive physical contact with the person or
another) and

Battery (intentional and un-permitted physical contact with
the person of another).

ii. Is not harmful to self or others but causes significant disruption of
the learning environment as defined by acting in any manner so as
to interfere with any teacher’s ability to conduct a class or other
school activity. These behaviors may require removal of the student
from the classroom in some instances. EXAMPLES INCLUDE BUT
ARE NOT LIMITED TO

Cursing
Tantrums

NHCS Behavior Criteria

4 Criteria Areas Continued
b) Replacement behavior goal set @ 75% for behavior that
i. Involves noncompliance without overt aggressive
behaviors generally referred to as
Insubordination (the refusal to carry out a
reasonable request by a staff member and/or
refusal to abide by reasonable school and/or
classroom rules). EXAMPLES INCLUDE BUT ARE
NOT LIMITED TO
- Ignoring adult requests or directives to return
to seat, start assignment, and redirect to
assignment or assigned physical space
ii. Involves lack of work completion
iii. Involves time off task
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NHCS Behavior Criteria

4 Criteria Areas Continued

2. Rate of Growth below peers
a)  The trend line of the data must be compared to the aimline.
b) It must be compared based on the percentages used (75% or 100%).

c)  Must determine if the trend line of the data is not projected to intersect
with the aimline in 18 weeks OR less.

d)  If it is not projected to intersect in the 18 weeks or less then the rate of
growth criteria has been met.

3. Intensity and nature of instruction in the last
part of Level IIT must resemble specially
designed instruction.

4. Federal & state adverse educational impact is
met when each of the three criteria (1-3 in
this section) are met.

- Performance well below peers
- Rate of Growth below peers

- Intensity of instruction required in Level III resembles
specially designed instruction

Progress Monitoring

Using the Student’s Progress

to Monitor Effectiveness of the
PSM

Intervention Strategies

18
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Progress Monitor Student’s
Response to Interventions

. Pr'ogi(r‘ess monitor by observing student at least 3 times a
wee

+ Remember you need to progress monitor academic areas
that are impacted by the behavior

+ Chart results of your behavior observations and your
academic probes

+ Utilize same decision making strategies regarding changing
the interventions as you would with"an academic only issue

- Remember that students who have behavioral
issues but there is no educational impact will continue at
PSM intervention level but will not be eligible for
consideration for entitlement.

K

Example Baseline Data
on Tyler Teal

+ Student: Tyler Teal

* Grade 3

+ Target Behavior: On Task
* Baseline Data:

I just know
I can do my

- Day 1 26/60 = 43%
- Day 2 46/60 = 77%
- Day 3 32/60 = 54%
- Median 32/60 = 54%
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Set Goal for Tyler Teal

« On task behavior falls under ' Ievel of
behavior necessary for success” or
proficiency level which is 75%

+ Goal for Tgler Teal's on task behavior
would be 45/60 (75%).

* Current baseline for Tyler Teal is 32/60
or 54%

Name: Tyler Teal

Target Behavior:
On Task

Baseline (Median):
32/60 or 54%

Goal:  45/60 or
75% Proficiency

(vl | L B[ [ [ ] ]
weole | [0 L[| [ ] ]
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Will Tyler Teal get to
Proficient Level within 18
weeks of Intervention?

+ Consider whether Tyler will likely reach the
75% within 18 weeks or less

+ Ask if Tyler's projected “on task” behavior
(trend) line will intersect the "aim line” within

the time period above.

If no, then the If yes, the "Growth
“Growth Rate” Rate” Behavior
Behavior criteria has criteria has NOT
been met. been met.

L
Another Example:

=7 V.
Situation: Toby has low incidence but high intensity *
behaviors that meet the definition of “assault” .
(i.e. hitting adults & peers such that there are
safety concerns)

Toby's Baseline: 4 thirty minute intervals in a day
without incident (4/12) or 33%.

Goal : 12/12 intervals without incident or 100%.
Note: There are 12 thirty minute intervals in the

day. (6 hour day) i' e, l\,.
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Progress Monitoring

Name: Toby Toms
Target Behavior:
Time without Assaults
Baseline (Median): 4/12 or 33%
Goal: 12/12 or 100%

Baseline = 54%
Day 1 = 4/12 = 33%
Day 2 = 4/12 = 33%
Day 3 = 3/12 = 25%
Day 4 = 4/12 = 33%
Day 5 = 5/12 = 42%
Day 6 = 4/12 = 33%
Day 7 = 5/12 = 42%
Day 8 = 5/12 = 42%
Day 9 = 6/12 = 50%
Day 10 = 6/12 = 50%
Day 11 = 6/12 = 50%
Day 12 = 5/12 = 42%
Day 13 = 6/12 = 50%
Day 14 = 6/12 = 50%
Day 15 = 5/12 = 42%

EENATENN
I D N N I
M Y S

Progress Monitoring

- Teacher records intervals
without incidents in the 12
thirty minute intervals during
each day. Simply use checks
on a chart for intervals
without incident.

- Record your data on a
Progress Monitoring chart.

What about
Toby Toms?
Would you
project that
he will reach
100% in 18
weeks or less?
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Some Notes f\(—I'

- Be very specific in defining the behavior you plan
to target for progress moni‘roring. Example: What
does “on task™ behavior look like?

+ Don't make the mistake of observing and
collecting data on the negative behavior only.

- Be sure to progress monitor the positive behavior.

+ Don't teach any of the behaviors in your BIP until
you get your baseline data.

* When doing progress monitoring use same the
time frame for collecting data and stick to
straight numbers and not percentages (if
possible).

Resources
e NHCS Positive Behavioral Interventions
and Supports Training Modules

e NHCS Special Education & Related
Services Manual

e "Practical Charts for Managing
Behavior” by Lynn Lavelle (Pro-ed
Publishing)

e Web Resources

-www.pbis.org
-http://cecp.air.org
-www.interventioncentral.com
-www.udel.edu

_http://darkwing.uoregon.edu/~ttobin/
= (Click on Case Study)

-http://www specialconnections.ku.edu/cgi-
bin/cgiwrap/specconn/main.php?cat=behavior&section=cases

-http://usfcollab.fmhi.usf.edu/expertdetail.cfm?staffid=4
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USP Training
Tucson Unified School District
2014-15
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Understand Restorative Practices uses an
explicit framework designed to re-establish
significant relations following behavior
incidents

Understand the elements of the Restorative
Practices Continuum

Learn and be able to use affective
statements, restorative questions, and circles
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Explain the rationale and benefits of
operating in the “"with” quadrant of the Social
Discipline Window

Explain Fair Process

Use the Restorative Questions that focus on
fair process

Explain the Fundamental Hypothesis
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To develop community and to manage
conflict and tensions by repairing harm and
restoring relationships

To revise our thinking to view conflictin a
school setting as an opportunity to foster
learning and build better relationships

To support students and engage them in
finding ways to curb their own negative
behavior
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If parents asked you...

"What things help you to control students but
still enable them to learn and enjoy their
school experience?”
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If parents asked you...

"How do you challenge students in a way that
helps them think about their behavior, yet
still allow them to feel okay about themselves
and you?”
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How important is it that students and their
narents understand the rationale for your
dractice?

Where are you coming from?

What are you all about?

How confident would you be at
explaining/describing the rationale for your
practice?
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If you struggle a little explaining/describing your
practice rationale, it is probably because
You intuitively know what works

It is based on custom and practice, including a range
of assumptions

You have probably never had to explain it in this way

If you can identify with the statements above,
your practices are likely to be located within an
“implicit framework”.
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Good relationships are the basis for learning.
Anything that affects relations (such as
inappropriate behavior) impacts learning.
Challenging inappropriate behavior needs to
be experienced as an opportunity for
learning.

As a society when someone does the wrong
thing, what is our most usual response?
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Who should Mary have given the
money to?

Who is going to be upset when they

find out that Mary spent some of
the money?
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Then Mary’s mum found out
about the money!!!!

1 [0). A
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Who should speak first?
What questions should be asked?

What would you expect to happen in this
meeting?
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How did this meeting help Mary fix or restore
things with the Murray family and her own
family?

What would have happened if there was no

meeting and her parents just returned the
money and punished Mary?
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What helped this story have a happy ending?
When we just punish kids in school, we don't

always make an effort to do the other things
that will help bring about a happy ending.
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informal formal
affective affective  srrall impromptu group formal

staternents  guestions  conference ProGess cohference
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Express your feelings ("I” statements)
The more specific and emotive, the better

One of the easiest and most useful tools for
building a restorative classroom/environment
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Stop teasing Sandy. It makes me uncomfortable when I hear
you teasing Sandy.

Talking during class is inappropriate. | am frustrated that you aren’t listening to
me.

| don’t want to see you fighting with him. 1 was shocked to see you hurt Pete.

Good job today, Sam. Sam, | was really happy that you worked
for the entire class period today.
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Affective questions help to elicit what a
student is thinking and feeling.
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Are responses to negative behavior and conflict
Address inappropriate behavior in a way that
places the responsibility for making things right
and restoring relationships on those involved in
the situation

Provide a voice for those harmed

Require a response — verbal or written
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"Why" questions are not present — This reduces
the impetus to rationalize or justify the
inappropriate behavior

Restorative Questions foster a process of
reflection by asking questions that will get the
misbehaving person to think about the behavior
and how it impacted others

Questions are restorative if they are used
properly
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hat happened?

nat were you thinking at the time?

hat have you thought about since?

no has been affected by what you have
done? In what way have they been affected?
What do you think you need to do to make
things right?

=S ===

The Restorative Practices Handbook, p. 16
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What did you think when you realized what
had happened?

What impact has this incident had on you and
others?

What has been the hardest thing for you?
What do you think needs to happen to make
things right?

The Restorative Practices Handbook, p. 16
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Are questioning exercises that quickly resolve
lower-level incidents with 2 or more people.
Ask both the wrongdoer and those harmed to
answer Restorative Questions in front of one
another

Are confined to structured conversations
based on a set of Restorative Questions
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Are meetings with participants seated in a
circle

Are often a sequential go-around

Are designed so students increase ownership
for facilitation circles

Are NOT held in response to an incident or
problem

Provide opportunities for students to share
feelings, ideas and experiences to build trust
Account for 80% of total circle experience
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Are meetings with participants seated in a circle
with the facilitator setting a positive tone

Are often sequential go-around

Are a vehicle for using peer pressure to get
positive change in behavior

Require the appropriate level of safety and
community to handle high-risk sharing

Make it possible to air feelings, repair harm,
solve problems and plan changes for the future
Accounts for 20% of the total circle experience
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Are a structured protocol used in response to
serious incidents or a cumulative pattern of
less serious incidents

Are meetings where all of those involved in
an incident come together with a trained
facilitator who was not involved with the
incident

Are NOT a routine class process

Are the most formal type of restorative
practices on the continuum
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Circles are a structured format that are used
to facilitate restorative practices.
Schools can use circles for:

1. Conflict Resolution (Responsive)

2. Building school community (Proactive)

3. Enhancing learning — as part of the curriculum
(Proactive)
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Punitive strategies often used by schools and
criminal justice systems involve control only
(discipline, limit-setting).

They do things TO students or offenders

They do not reduce misconduct or crime by
internalizing appropriate behavior.

They do not satisfy victims or restore peace to
communities.

They generate a cycle of alienation, crime and
punishment.
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At the other extreme, permissive strategies
involve only support (encouragement,

nurturing) and just do things FOR students or
offenders.

Permissive strategies do nothing to change
behavior or meet victim or community needs.
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Restorative strategies engage people, doing
things WITH them, rather than TO them or
FOR them.
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An approach to decision-making that is in the
“with” quadrant of the Social Discipline
Window

People are treated respectfully throughout a
decision-making process and they perceive
that process to be fair, regardless of the
outcome.

Does not mean every decision is made by
vote or by consensus
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Engagement
Explanation
Expectation Clarity
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Engagement means that everyone affected
by a decision is given the chance to provide
input and have an opportunity to discuss
various possible courses of action.

* The Restorative Practices Handbook, p. 87
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Explanation means that after a leader has
made a decision, that decision and the
process and reasoning behind the decision
are made clear to all stakeholders.

The Restorative Practices Handbook, p. 87
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Expectation clarity means that everyone
involved understands the implications of that
decision, the specific expectations and the
consequences for failing to meet those
expectations.

The Restorative Practices Handbook, p. 87
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Fair process

s not decision by consensus

Does not set out to achieve harmony

Does not set out to win people’s support
through compromises that accommodate
every individual’s opinions, needs or interest
Is not managers forfeiting their prerogative
to make decisions, establish policies and
procedures
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Open channels of communication and about
giving people reason to believe that their
ideas and feelings truly have been taken into
account

A feeling of being treated fairly — evenif the
outcome is different from what was preferred
or desired

The Restorative Practices Handbook, p. 86
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Recognizes shame is a critical requlator of
human social behavior

Anticipates the shame response when
positive affect is interrupted

Relates to both wrongdoer and those harmed
Anticipates the shame response in every
situation where people are confronted with
consequences of misbehavior

Helps people transform and move beyond
shame
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Current research shows that academic success is
based on emotional well-being. Our students need to
understand themselves emotionally so that they may
have control over how they interact with others. If we
feel connected with others, we can have the
receptivity to learning. In our world today, employers
are hiring people who can interact well with others,
those with leadership abilities and those who can
work as a team member. We are not equipping our
children for the work force. More than ever, the
emphasis is on academics —we are neglecting the
emotional well-being of our young people.
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Teachers and other school personnel can
learn some basic yet powerful ways to help
students understand and control their
emotions. When students have an emotional
outburst or disturbance, for the most part we
suspend them. The teachable moment is lost.
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Healthy Shame

Toxic Shame
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In this instance, we feel that what we did
was bad or wrong, not that we are bad or
wrong people.

Our integrity is maintained; we know we
are still loved for who we are. We change
the negative behavior because we feel
loved and accepted.

Separated the deed from the doer.

4. RESTORATIVE PRACTICES (INTRO) (Introduction to Restorative Practices (ppt)) VI-58 p. 197



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 198 of 225

We believe that we are bad or wrong people.
We feel humiliated and unloved. We believe
that we are flawed and that there is no way
back.

When we are in toxic shame, we react in
different ways. We are attempting to escape
from the feeling (Compass of Shame).
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Traditionally, when we suspend students, we
cause them to feel resentful and shamed. We do
not usually provide a way for them to be
reintegrated back into the school environment.
Yet, we all have a strong need to feel that we
belong. To meet this need, students may seek
subculture groups such as gangs. Is it possible,
when we shame students without providing
reintegration, we are encouraging gang
involvement, drug use, (fill in the blank)?
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Human beings are the happiest, healthiest
and most likely to make positive changes in
their behavior when those in authority do
things with them rather than to them or for

them
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Cornerstone of Restorative Practices
Framework to examine daily interactions and

to become intentionally restorative on a
consistent basis
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Changing your own attitude

Believing in students especially when they
seem to be behaving badly

Improving the relationship

Holding people responsible for appropriate
behaviors

4. RESTORATIVE PRACTICES (INTRO) (Introduction to Restorative Practices (ppt)) VI-58 p. 204



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 205 of 225

For Restorative Practices to be explicit, it must
actively integrate:

Restorative Questions
Social Discipline Window
-alr Process

Psychology of Affect
~undamental Hypothesis
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The Restorative Practices Handbook for Teachers,
Disciplinarians and Administrators. (2009). Costello,
B., Wachtel, J., & Wachtel, T.

Restorative Practices Whole-School Implementation
Overview

www.iirp.edu/pdf/SSS Implementation Overview.pdf
A Restorative Story: Mary Finds Some Money. (2007).
Davey, L., & Preston, N.

Just Education: Restorative Practices for Educators.
(2006). Milwaukee Public Schools (LaCocque, P. &
DeFino, M.) & Marquette Law School/Restorative
Justice Initiative (Mambu, T.).

4. RESTORATIVE PRACTICES (INTRO) (Introduction to Restorative Practices (ppt)) VI-58 p. 206



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 207 of 225

Tsuru Bailey-Jones

Director of Academic Equity, Asian Pacific
American Student Services

(520) 232-8614
Tsuru.baileyjones@tusdi.org
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YOUTHN
MENTAL
HEALTH

FIRST AID

First Aid USA

FOR ADULTS ASSISTING YOUNG PEOPLE

6. YOUTH MENTAL HEALTH, FIRST AID TRAINING (Youth Mental Health — First Aid USA Manual (manual)) VI-58 p. 208



Case 4:74-cv-00090-DCB Document 1851-7 Filed 09/30/15 Page 209 of 225

Formal Discipline Training
for Administrators

Department of Student Services, the

Legal Department and the
Exceptional Education Department

Objectives

Read and understand GSRR

Due Process

Exceptional Education/504 Students

Disciplinary Decisions Aligned with GSRR
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Section A: Purpose

Topics

* What Are the Guidelines and why are they
needed?

Section A: Purpose

Topics

* When do they Apply?
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What are the Guidelines and
Why Are They Needed........

Specifies rights

Describes conduct

Provides Consistency

Assures rights

When do These Guidelines Apply?

e During school hours

e While being transported on the school bus or
other school district-sanctioned
transportation

e At times and places where the principal or
other school official or employee has
jurisdiction over students

During school-sponsored events
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When do These Guidelines Apply?

During field trips

During athletic functions

When students are going to and from school
(“portal to portal”)

During other school-related activities

Check for Understanding:

* Why are the Guidelines needed?

e Name two occasions when the Guidelines are
in force?
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Answers

Specify the rights and responsibilities of
students and parents

During school hours

During field trips

(answers may vary)

Section B: Student and Parent
Rights and Responsibilities

Topics
» Student Rights

* Student Responsibilities
* Parent Rights

* Parent Responsibilities
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Section B: Student and Parent
Rights and Responsibilities
Topics
e Student Rights

e Student Responsibilities
* Parent Rights

* Parent Responsibilities

Section B: Student and Parent
Rights and Responsibilities
Topics
e Student Rights

e Student Responsibilities
* Parent Rights

* Parent Responsibilities
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Section B: Student and Parent
Rights and Responsibilities

Topics
e Student Rights

e Student Responsibilities
* Parent Rights

* Parent Responsibilities

Rights and Responsibilities

Students have aright to........ pg. 7-8

Students have a responsibility to.......... pg. 8

Parents/Guardians have a right to......... pg. 9

Parents/Guardians have a responsibility

to....pg. 9
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Student Rights Summary

* Expect rigor

* Expect equity

* Expect appropriate behavior from staff
* Expect safety

* Expect communication

* Expect privacy

Student Responsibility Summary

e Regular attendance
* Preparedness
* Participation

* Respectful behavior
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Parents Rights Summary

* Communication
* Notification

* Respect

e Conferences

* Access to records

Parents Responsibilities Summary

* Communicate

e Collaborate

* Partner

* Be responsible

* Ensure student compliance
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Check for Understanding:

* Name two student rights

* Name two parent rights

Answers

* Be expected to achieve at high levels

* Receive fair, equitable, non-discriminatory disciplinary
actions that are aligned with the GSRR.

* Receive official reports of the student’s academic
progress

* Request a review of all disciplinary actions related to
their student

* (answers may vary)
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Section C: Governing Board Policies
and General Information

Topics

e Governing Board Policies

Positive Behavior Interventions and Supports

Restorative Practices

Abeyance Contracts

Important Information

Section C: Governing Board Policies
and General Information

Topics

e Governing Board Policies

Positive Behavior Interventions and Supports

Restorative Practices

Abeyance Contracts

Important Information
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Section C: Governing Board Policies
and General Information

Topics

e Governing Board Policies

Positive Behavior Interventions and Supports

Restorative Practices

Abeyance Contracts

Important Information

Section C: Governing Board Policies
and General Information

Topics

e Governing Board Policies

Positive Behavior Interventions and Supports

Restorative Practices

Abeyance Contracts

Important Information
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Section C: Governing Board Policies
and General Information

Topics

e Governing Board Policies

* Positive Behavior Interventions and Supports
* Restorative Practices

* Abeyance Contracts

* Important Information

Governing Board Policies

e Equal Educational Opportunities & Anti-
Harassment (Policy JB) pg. 10

» Dating Abuse Policy (Policy JICL) pg.10

* Bullying, Intimidation & Harassment (Policy
JICK) pg.11

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 221
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Governing Board Policies Cont.

* School Dress Code (Policy JICA) pg. 11

* Cell phones and Other Electronic Devices
(Policy JICJ) pg. 12

* Hazing (Policy JICFA) pg.13

JB Summary

e Discrimination is prohibited
e TUSD will act to investigate all complaints

e TUSD will take appropriate action

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 222
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JICL Summary

* TUSD is committed to maintaining safe
environment

* Employees aware of abuse will respond in a
Board approved manner

e Students are encouraged to report abuse

JICK Summary

e Bullying is a form of harassment

e Students who engage are subject to
disciplinary action
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JICA Summary

* Appropriateness
* Neatness

* Cleanliness

* Modesty

JICJ Summary

* Kept out of view

* Not used during instructional time unless
authorized by teacher

* May be confiscated

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt))
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JICFA Summary

An intentional act

Usually an initiation

Supervision minimizes opportunity

Reports go to Superintendent

Positive Behavioral Intervention
and Supports (PBIS)

* Evidence based
* Proactive

e Data Driven

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 225
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PBIS is Created By......

e Defining and teaching behavioral expectations

* Monitoring and acknowledging appropriate
behavior

* Providing corrective and appropriate
consequences for behavioral errors

PBIS is Created By Cont.

e Providing appropriate services for students
who need additional behavioral supports

e Using a team-based management system to
oversee the PBIS program

* Using referral data for problem solving

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 226
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Restorative Practices

e Relationships

* Develops/restores community
e Accountability

e Allows voice

e Make amends

Abeyance Contracts

e Holds part of a suspension
e Optional
* Binding Contract

e Second Chance

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt))
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Check for Understanding:

 What is the Anti-Harassment Policy?
* What is the Dress Code Policy?

* What is the purpose of PBIS?

Answers

* JICK
* JICA

* Prevent problem behavior while teaching
socially appropriate behaviors
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Section D: Know the Actions

Topics

* When you must call law enforcement
* When you may call law enforcement
* Due Process

* Due Process Steps

Due Process for Ex ED/504 students

Section D: Know the Actions

Topics
e When you must call law enforcement

When you may call law enforcement

Due Process

Due Process Steps
Due Process for Ex ED/504 students
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Section D: Know the Actions

Topics

* When you must call law enforcement
 When you may call law enforcement
* Due Process

Due Process Steps
Due Process for Ex ED/504 students

Section D: Know the Actions

Topics
* When you must call law enforcement

When you may call law enforcement

Due Process

Due Process Steps
Due Process for Ex ED/504 students
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Section D: Know the Actions

Topics

* When you must call law enforcement
* When you may call law enforcement
* Due Process

* Due Process Steps

Due Process for Ex ED/504 students

Section D: Know the Actions

Topics Cont.

e Special Procedures

Action Levels

Consequences

Out of School Suspensions

Long Term Suspensions

Violations

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 231

23



Case 4:74-cv-00090-DCB Document 1851-8 Filed 09/30/15 Page 7 of 109

Section D: Know the Actions

Topics Cont.

e Special Procedures

Action Levels

Consequences

Out of School Suspensions

Long Term Suspensions

Violations

Section D: Know the Actions

Topics Cont.

e Special Procedures

Action Levels

Consequences

Out of School Suspensions

Long Term Suspensions

Violations
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Section D: Know the Actions

Topics Cont.

e Special Procedures

Action Levels

Consequences

Out of School Suspensions

Long Term Suspensions

Violations

Section D: Know the Actions

Topics Cont.

e Special Procedures

Action Levels

* Consequences

Out of School Suspensions

Long Term Suspensions

Violations
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Section D: Know the Actions

Topics Cont.

Special Procedures

Action Levels
Consequences

Out of School Suspensions
Long Term Suspensions
Violations

Law Enforcement MUST be Called

Threats to use or use of a weapon/dangerous
instrument

Aggravated assault

Sexual conduct with minor under 15 years old
Possession, use or sale of illegal drugs

Bomb threats

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt))
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Law Enforcement MAY be Called

* Possession, sale or distribution on dangerous
substances (including legal drugs or alcohol)

e Student demonstration which is likely to
create unsafe conditions

e Threats

e Assault

e Vandalism

e Setting off false fire alarm

Due Process

e Legal safeguard

* Protects student rights

e Constitutionally guaranteed

e Protects administrators
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Due Process Steps

Oral or written notice to the student of the
charges against the student

An opportunity to present the student's side of
the story in an informal hearing or meeting

The allowance, for safety considerations, for a
student to be removed from the school prior to
an informal hearing with that hearing to follow as
soon as practical

Adequate notification and an opportunity for a
fair hearing

Due Process Steps Cont.

That parents will be informed in writing of all
suspensions and that they have the right to a
conference with the principal

That if parents are not satisfied with any school
official's decision they are entitled to request a
review by the school official's immediate
supervisor

VI-58 p. 236
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Due Process Steps Cont.

e Formal due process (including a hearing officer)
in long-term suspension and expulsion
proceedings

e Aright to appeal disciplinary decisions to the
Principal, Director or Assistant Superintendent

Due Process for Students
with IEP’s or 504’s

e Students with disabilities under Section 504 or
IDEA (and students suspected of having a
disability) may be disciplined in the same
manner as any other student and may be
suspended for up to 10 cumulative days of
school per school year.

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 237
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Due Process for Students
with IEP’s or 504’s

 |f a suspension beyond 10 cumulative days is
contemplated, special procedures must be
followed.

A manifestation determination conference
must be held prior to the 11t" day of
suspension

Special Procedures

If the manifestation determination
conference concludes that the student’s
behavior is a manifestation of the student’s
disability, then no further disciplinary action
can be taken.

The 504 or IEP team should convene to
develop an appropriate behavior plan for the
student

VI-58 p. 238
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Special Procedures

e |f the manifestation determination conference
concludes that the student’s behavior is not a
manifestation of the student’s disability, the
District may impose whatever long-term
suspension or expulsion it would impose
under the same circumstances if a non-
disabled student were the offender.

Special Procedures

* The District has no obligation to continue to
provide educational services to a 504 student
during the period of a long-term suspension
or expulsion. However, the District must
continue to provide educational services for
students eligible under IDEA. Please refer to
the appropriate Governing Board Policies JKAA
and JKAB and to the Exceptional Education
Handbook for specific procedures

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 239
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Section E: Discipline, Students
with Disabilities and Compliance

Topics
e Special Circumstances-1AES

Section E: Discipline, Students
with Disabilities and Compliance

Topics

e Suspension less than ten days
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Section E: Discipline, Students
with Disabilities and Compliance

Topics

e Suspension more than ten days

Special Circumstances — |IAES,
Interim Alternative Educational Setting

45 Day Interim Alternative Educational Setting:
e Weapon - Student carries or possesses

e Drugs (Controlled Substances Act) — carries,
possesses, uses, sells, solicits

e Serious Bodily Injury — Inflicts (USC 13659(g))
A substantial risk of death

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 241
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Special Circumstances — |IAES,
Interim Alternative Educational Setting

Disciplinary Removals for less than 10 days:
e Case by case determinations

* May remove to “interim alternative
educational setting, another setting, or
suspension”

* In the same manner as applied to students
without disabilities

Special Circumstances — |IAES,
Interim Alternative Educational Setting

Disciplinary Removals in Excess of 10 days:

e Must provide services for students with
disabilities beginning on the 11th day

e Must provide appropriate behavioral
interventions

e Must hold a Manifestation Determination
Review
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Special Circumstances — |IAES,
Interim Alternative Educational Setting

Disciplinary Removals in Excess of 10 days Cont.:

 When imposing discipline for a violation of the
student code of conduct after the first 10
cumulative days of removal, school personnel
must always be mindful of the disciplinary
history of the student and ask, “Will this
removal constitute a change in placement?”

Action Levels

5 levels of Violations
e 1 and 2 considered ‘lower’ violations

3 mid-range

4 serious

5 most serious- potential expulsion

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 243

35



Case 4:74-cv-00090-DCB Document 1851-8 Filed 09/30/15 Page 19 of 109

Consequences

Levels 1,2 and 3 - Wide range of options

Levels 4 and 5 - Require along term
consequence (11 to 180 days)

pg. 20
Important Information -

pg. 21

Out of School Suspensions

Short Term
e Level 3 violation = 1-10 days

Long Term

e Level 4 violation = 11-30 days

e Level 5 violation = 11-180 days
(possible expulsion)
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Long Term Suspensions

e Process- refer to JK-R2
e Homework

e Life Skills Suspension Program (LSSP)

Violations

e 14 violation categories identified by the
Arizona Department of Education

e Almost all violations have a sub-category:
the “Dishonesty” category has four:
0 Cheating
O Forgery
O Lying
O Plagiarism

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 245
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Things to Remember

e As the disciplining administrator it is your
responsibility to assign the correct sub-
category to the students violation

* The sub-category has a violation level
e That level dictates your disciplinary options

 |f you are unclear as to which disciplinary
actions are appropriate, contact your Director
or Assistant Superintendent

Scenario

Minnie Mouse was in class working on her math
assignment. She left her desk to get a ruler. As
she was walking an item fell out of her pocket.
Mickey Mouse picked up the item and gave it to
the teacher. It was a bottle of vodka.
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Quiz

T/F-Following the GSRR is optional
T/F-THE GSRR is not in effect during field trips

T/F-Students have a responsibility to display
behavior that does not compromise the safety
of other students and/or staff

T/F-Aggravated Assault is a mandatory report
to law enforcement

T/F-Restorative Practices should not be used

Quiz

What does PBIS stand for?

What are the required actions for a level 1
violation?

What is the action level for fighting?
What is the action level for sharing alcohol?

Is it appropriate to call law enforcement for a
disruption violation?

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt))
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Thank youl!

If you need assistance, contact your
Assistant Superintendent,
Director or the
Department of Student Services

7. ADMINISTRATOR TRAINING (Formal Discipline Training for Administrators (ppt)) VI-58 p. 248
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Guidelines for Student
Rights and Responsibilities

«

Discussion Topics

- Student Assemblies and
Parent Information Nights

- Process and Flow Chart
- Key Points

- Data Monitoring

\ SY 2013-2014 USP VI D2

8. ADMINISTRATOR TRAINING (Guidelines for Student Rights and Responsibilities (ppt)) VI-58 p. 249
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Student Assemblies and
Parent Information Sessions

USP Section VI(B)(2)(b)(2)

SY 2013 -2014 USP VI D2

Process and Flow Chart

\ SY 2013-2014 USP VI D2
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Key Points:

Keep students in the classroom as often
is practicable (USP)

USP Section VI(A)(2)

\ SY 2013 -2014 USP VI D2

Key Points:

Exclusionary Consequences can only be
used for Level 3 violations when both
conditions below are met:

1. “Ongoing or Escalating” 2. Documented Interventions

GSRR Page 5USP Section VI(A)(2)
\ SY 2013 -2014 USP VI D2

8. ADMINISTRATOR TRAINING (Guidelines for Student Rights and Responsibilities (ppt))  y]-58 p. 251
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Key Points:
What is “Ongoing” Misbehavior?

On Monday, student A had a shoving match
with student B. A restorative conference was
held. On Tuesday everything went well, but on
Wednesday student A kicked and shoved
student C.

GSRR Page 5USP Section VI(A)(2)

\ SY 2013-2014 USP VI D2

Key Points:
What is “Escalating” Misbehavior?

Student D disrupts her science class daily.
There have been several restorative
conferences. The restorative conferences have
not worked and her behavior has worsened.

GSRR Page 5USP Section VI(A)(2)

\ SY 2013-2014 USP VI D2
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Questions?

SY 2013 -2014 USP VI D2
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Academic
304 review or referral for services
Academic Support Plan
Child Stedy Requested
Coach or sponsor contacted (if student is involved in extra-curricular)
Conference period azsigned
Consultation with Exceptional Education Case Manager
Coungeling Provided
Guidance Counselor/Career Center Referal
IEP review meeting reguested
Individual Conference with student
Magnet Coordinator Contacted
Other
Parent Centact by teacher
Parent teacher conference(s)
Pastive student recognition
Referral to school nurse
Saturday School
Social Services contacted {send referral to student's counselor)
Student coniract
Student Support Senvices refemal
Tutoring

m

Attendance
Aftendance Suppoart Plan

Coach or sponsor contacted (if student is involved in extra-curricular)

Drop Out Prevention notified

Guidance Counselor/Career Center Refemal

Mentor assistance

Other

Parent Contact by teacher

Parent teacher conferenceds)

Referral o =chool nurss

Social Semvices contacted (send referral to student’s counselor)
Student Support Services referral

10. ADMINISTRATOR TRAINING (Interventions and Discipline Actions (ppt))
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Behavioral
504 review or referal for senvices
Behavior management plan
Child Study Requested
Coach or sponsor contacted (if stuedent is involved in extra-curricular)
Consultation with Exceptional Education Case Manager
Coungeling Provided
Guidance Counselor Referral
IEF review meeting reguested
Individual Confersnce with student
Magnet Coordinator Contacted
Mentor azsistance
Other
Parent Contact by teacher
Parent teacher conference(s)
Pear Medistion
Postive student recognition
Referral to 2chool nurss
Restorative Circle
Resforative Conference
Restorative Response
Social Services contacted (send referral to student's coungelor)
Student confract
Student Support Services refemal

INTERVENTION DISCIPLINARY ACTION

Restorative/PBIS intent Could be restorative
and/or and/or punitive in nature
out-come

Mojave Intervention Block  AZSafe

Focus on Prevention Reactive

NOTE: All disciplinary actions should include
restorative component.
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running
It causing

10. ADMINISTRATOR TRAINING (Interventions and Discipline Actions (ppt)) VI-58 p. 260
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Welcome to the Tucson Unified School District Student Equity training for Administrators.
It is necessary for you to have your copy of the G.S.R.R for reference, or click on the G.S.R.R
links throughout this presentation.

12. ONLINE GSRR TRAINING (Online GSRR Training from True North Logic (ppt) VI-58 p. 262
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By the end of this training, participants will be able to navigate through and understand the
Guidelines for the Student Rights and Responsibilities handbook. Participants will also be
able to demonstrate and understand due process, and the federal guidelines for
Exceptional Education and five oh four handicapped students. They will also be able to
understand how to make disciplinary decisions in accordance with Governing Board Policy
JK

12. ONLINE GSRR TRAINING (Online GSRR Training from True North Logic (ppt) VI-58 p. 263
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What is the purpose of the Guidelines for the Student Rights and Responsibilities
handbook, and when do these specified guidelines apply?

12. ONLINE GSRR TRAINING (Online GSRR Training from True North Logic (ppt) VI-58 p. 264
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The purpose of the Guidelines for Student Rights and Responsibilities is to specify the rights
and responsibilities of students, parents, and guardians. It also describes conduct which
violates those rights and responsibilities. The G.S.R.R strives to ensure consistent
disciplinary actions throughout the District. These guidelines assure the rights of students,
parents, and guardians when disciplinary actions are taken.

12. ONLINE GSRR TRAINING (Online GSRR Training from True North Logic (ppt) VI-58 p. 265



Case 4:74-cv-00090-DCB Document 1851-8 Filed 09/30/15 Page 41 of 109

These Guidelines apply during school hours, while being transported on the school bus or
other school district sanctioned transportation; at times and places where the principal or
other school official or employee has jurisdiction over students; during school sponsored
events and field trips; during athletic and extracurricular activities (in and out of town) and
when students are going to and from school. Additionally, the principal is authorized to
begin disciplinary action when a student's misconduct away from school has a detrimental
effect on the other students, or on the orderly educational process, because the violation is
directly connected to prior violations at school, or threatens to produce further violations
at school.

12. ONLINE GSRR TRAINING (Online GSRR Training from True North Logic (ppt) VI-58 p. 266



Case 4:74-cv-00090-DCB Document 1851-8 Filed 09/30/15 Page 42 of 109

Please take a moment to record your answers.
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Some possible answers are. The Guidelines specify the rights and responsibilities of
students and parents. The Guidelines are in effect during school hours and while
administrators and, or employees have jurisdiction over students.
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This section discusses Student and Parent Rights and Responsibilities. T.U.S.D believes that
educating a student is a collaborative effort with the student and parent. To support this
collaboration we realize that each party has rights and responsibilities.
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Please read pages seven through eight of your GSRR to review the Governing Board
approved student rights,. page eight to review student responsibilities,. page nine to
review parent, and guardian rights,. and page nine to review parent, and guardian
responsibilities. Please click the continue button at the bottom right of the slide to move
forward.
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Students have the right to expect rigor, equity, and appropriate behavior from staff and
fellow students. They also have the right to safety, clear communication and privacy. In
addition, students have the right to receive homework from their home school while
serving a disciplinary suspension.

12. ONLINE GSRR TRAINING (Online GSRR Training from True North Logic (ppt) VI-58 p. 271
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Students have a responsibility to attend school regularly; to come to school prepared for
all classes; to participate in those classes and treat all members of the school community
with respect.

12. ONLINE GSRR TRAINING (Online GSRR Training from True North Logic (ppt) VI-58 p. 272
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Parents have a right to communicate with their child’s teacher and administrator; a right to
timely notification of their child's academic progress; a right to be treated with respect; a
right to have conferences with school staff and access to their child's academic and
behavior records.
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Parents have the responsibility to communicate with teachers, counselors and/or
principals. They have the responsibility to collaborate with their child's school; to be an
active partner in their child's education, be responsible for the child's health and welfare
and to ensure the child complies with the Guidelines.
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Please take a moment to record your answers.
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Some possible answers are: be expected to achieve at high levels; receive fair, equitable,
non-discriminatory disciplinary actions that are aligned with the GSRR; receive official

reports of their students academic progress and request a review if all disciplinary actions
related to their student.
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This section discusses Governing Board policies, Positive Behavior Intervention and
Supports, Restorative Practices, Abeyance Contracts and Important Information.
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Please take a moment and review each policy in the GSRR.
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Please take a moment to review each policy.
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Any discriminatory behavior is prohibited in TUSD. TUSD will investigate all complaints of
discrimination, whether the complaint is formal or informal and will take appropriate
action against anyone who is found to have violated this policy.
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TUSD is committed to maintaining a school campus environment that that is safe and
secure for all students and dating abuse will not be tolerated. Students are encouraged to
report known or suspected incidences of abuse. The District will investigate all complaints.
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Bullying is a form of harassment. It is the repeated intimidation of students by the real or
threatened infliction of physical, verbal, written or electronically transmitted harm.
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These dress guidelines represent minimum standards. Some schools may have additional
dress requirements such as a uniform policy.
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Electronic devices should be kept out of view. They may be kept in a pock or purse,
backpack or locker. They should not be used in class unless authorized be the teacher. If a
device is confiscated, staff will take reasonable steps to secure the device, however, the
District nor District staff is responsible for loss, damage or theft that may occur while the
device is confiscated.
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Hazing is an intentional act usually in connection with an initiation into an organization or
team. Hazing may result in physical and emotional injury. Students my report an incident
to any professional staff member. That staff member will report it to the school
administrator who will report it to the Superintendent.
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Positive Behavioral Interventions and Supports (“PBIS”) is an evidence-based,
proactive, data driven framework that includes a range of tiered interventions
designed to prevent problem behavior while teaching socially appropriate
behaviors. The focus of PBIS is creating and sustaining school environments for all
students in which appropriate behavior is supported and problem or disruptive
behavior is redirected.
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Defining, reaching and modeling behavioral expectations. Monitoring and acknowledging
appropriate behaviors and providing corrective and appropriate consequences for
behavioral errors.
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Restorative Practices is an approach that seeks to develop good relationships and
restore a sense of community. Restorative Practices: focuses on repairing harm
caused by an offending behavior, while holding the wrongdoer accountable for
his/her actions; provides an opportunity for the affected parties (victim, wrongdoer,
and community) to identify and address their needs as a result of the offending
behavior, and make amends or find a resolution; and surrounds the affected parties
with a community of care, in which all parties share in the resolution of the
problem.
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An administrator may offer to not immediately impose the assigned out-of-school
suspension if, One. The

administrator believes it is in the best interest of the student and the school
community, Two. The student

admits to committing the infraction, Three. The student and parent or legal
guardian agree to certain conditions,

And, Four. The student and parent or legal guardian sign a contract, called an
abeyance contract. The terms of

the abeyance contract may not exceed the maximum suspension term for the
offense level but never to exceed 90 days. If a student

violates his or her abeyance contract with a suspendable offense, the student must
serve the remaining term

of the initial offense, plus the suspension for the additional offense. These two
suspensions would be

served concurrently. This contract allows the student a second chance to remain in
their inclusive environment.
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Please take a moment to record your answers.
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Please check your answers.
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This section discusses law enforcement contact, due process, suspensions and violations.
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This section discusses special procedures, action levels, consequences, short and long term
suspensions and violations.
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Other violations that require law enforcement contact are homicide, sexual assault, armed
robbery, kidnapping and any dangerous crimes against minors and arson of an occupied
structure.
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Under certain circumstances, contacting TUSD’s Department of School Safety is
appropriate.
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Due process is a legal safeguard that protects student rights. It is constitutionally
guaranteed and following the steps protects the disciplining administrator.
Following the Due Process steps are mandatory, failure to do so will result in the
disciplinary actions being overturned.
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Due process steps include: oral or written notice to the student of the charges against the
student; an opportunity to present the student's side of the story in an informal hearing or
meeting; the allowance, for safety considerations, for a student to be removed from the
school prior to an informal hearing with that hearing to follow as soon as practical;
adequate notification and an opportunity for a fair hearing; if parents are not satisfied with
the school officials decision they are entitled to request a review by the school officials
immediate supervisor; formal due process involves a hearing officer and the right to
appeal disciplinary decisions to the Assistant Superintendent or Director.
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Students with disabilities under Section 504 or IDEA (and students suspected of having a
disability) may be disciplined in the same manner as any other student and may be
suspended for up to 10 cumulative days of school per school year.
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If a suspension beyond 10 cumulative days is contemplated, special procedures must be
followed. A manifestation determination conference must be held prior to the 11t day of
suspension.
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If the manifestation determination conference concludes that the student’s behavior is a
manifestation of the student’s disability, then no further disciplinary action can be taken. If
the manifestation determination conference concludes that the student’s behavior is NOT a
manifestation of the student's disability, the school may proceed with disciplinary actions.
The District has no obligation to continue to provide educational services to a 504 student
during the period of a long-term suspension or expulsion. However, the District must
continue to provide educational services for students eligible under IDEA. Please refer to
the appropriate Governing Board regulations JKA and JKAB and to the Exceptional
Education Handbook for specific procedures
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This section discusses Interim Alternative Educational Services, suspensions less than 10
days and suspensions more than 10 days.
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An IAES may be recommended if the behavior is related to the disability ONLY if the student
commits one of the “Big Three”: weapons, drugs or serious bodily injury. Serious bodily
injury is defined as an injury that involves a substantial risk of death, unconsciousness,
extreme physical pain, obvious disfigurement, the loss or impairment of the function of a
member, organ or mental faculty.

If an IAES placement is made, the IEP must be amended to reflect the placement.
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If an Exceptional Education student receives a suspension of more than 10 days, the school
MUST provide academic and behavioral interventions for that student.
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Examples of level 1 violations are verbal provocation, dress code violation and tardies.
Examples of level 2 violations are disruption, petty theft and a minor aggressive act.
Examples of level 3 violations are fighting, hazing and vandalism.

Examples of level 4 violations are assault, drug use and fire alarm misuse.

Examples of level 5 violations are selling drugs, aggravated assault and school threat..
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There are many disciplinary options for low level violations. On page 20 of the GSRR, the
bold actions are the minimum and mandatory actions for that level. A long term
consequence could be a combination of short term suspension with an abeyance contract,

or a long term hearing may be considered. Please read the important information ( pg 21
of the GSRR) to review those special notifications.
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An administrator must have documented interventions listed in Mojave prior to
resorting to an out of school suspension for a level 3 violation.
Only a Hearing Officer may suspend a student from school for more than 10 days.

Long-term suspensions of more than 30 days shall not be imposed except for
Violations at Level 5.
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An administrator may NOT out of school suspend a student for level 1 or level 2
violations. Suspensions may occur for level 3 violations, however, principals must
limit exclusionary consequences to instances in which student misbehavior is
ongoing and escalating, and the District has first attempted and documented they
types of intervention(s) used in PBIS and/or Restorative Practices, as appropriate.
Conferences to resolve the problem must be scheduled with the parent, student,
and other appropriate school staff members as part of the continuum of supports
and interventions implemented to support student success.
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The school may be required to provide homework for the suspended student. A long term
suspended student will be provided the opportunity to attend TUSD’s alternative to
suspension program (LSSP): General Education students will be referred if they receive a
suspension of 20 days or more. Exceptional Education students will be referred if they
receive a suspension of 11 days or more. If the student/parents decide against attending
the suspension program, it is the home schools responsibility to provide work.
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The ADE violation categories are: Aggression; Alcohol, Tobacco and Other Drug Violations;
Arson; Attendance Policy Violation; Dishonesty; Harassment and Threat, Intimidation;
Homicide, Kidnapping; Other Violations of School Policies; School Threat or Interference;
Sexual Offenses; Improper Use of Technology; Theft; Trespassing, Vandalism or Criminal
Damage and Possession of Weapons and Dangerous Items.
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As the disciplining administrator it is your responsibility to assign the correct sub-category
to the students violation, the sub-category has a violation level, that level dictates your
disciplinary options, if you are unclear as to which disciplinary actions are appropriate,
contact your Director or Assistant Superintendent.
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Take a moment to reflect on how you would address this violation at your site. Should the
same action be taken for a first grader and an eleventh grader?
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Thank you for your time in reviewing the Tucson Unified School District’s Student Equity
training for Administrators.
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Informational Presentation about
our School’s Culture, Studen
Expectations, and Discipling
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Establish
Common
Expectations

e —
Preventative
!ﬁm Approach
Consistently Ongoing
Encourage and Reinforcement
Communicate and Recognition
Creates a

positive, safe
school climate to
maximize success

Example of PBIS — Matrix of Expectations

SETTING
Library/
All Settings | Hallways | Playground | Cafeteria | Computer | Assembly Bus
Lab

Respect
Ourselves

Respect
Others

EXPECTATION

Respect
Property
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5 building,
) . lonships across
school cormmunities through positive changes
in behavior.
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The Purpose of The Guidelines for Student
Rights and Responsibilities

Explains the rights and responsibilities of students

Describes behavior which violates the rights and
responsibilities

Aims for consistency throughout the District

Assures the rights of students when disciplinary action is taken
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o Parent Notification o Detention (before or after school) o Reassignment To Different Class
and Conference Request o Peer Mediation o Behavior Contract
) Student Conference o Privileges Suspended o Behavior Intervention Group
o Restorative Circle o Restitution o Threat Assessment
o Restorative Conference o Saturday School o Behavior Intervention Plan
o Confiscation of Contraband o Teen Court ) o Lunch Detention
. ° Student Verbal Apology o Functlpnal Behe_wiral Assessment o Momtonng of Selected Problem
3 o Student Written Apology o thavwr Learning Packets Behaviors ) ) )
g ° Warning o Time o_m o Other Agtlcn (con_slstem with
u_lJ ° Referred to Outside Agency o Reflective Essay other Level 1 interventions and approved
o Meeting With School Counselor by the RPPSC).
o Community Service (not work detail)
~ Any Action from the prior level(s) may also be imposed.
il (o} Restorative Conference and/or Restorative Circle
a o Social Skills Groups and/or Mentoring
- 0 InSchool Suspension (1-3 days) only after Restorative Practices have been implemented but deemed
ineffective
Any Action from the prior level(s) may also be imposed.
« |0  Short-Term In School Action and/or Abeyance
o 0  Restorative Conference and/or Restorative Circle
5 o In School Suspension — Short-Term (1-10 Days)
= o Out Of School Suspension and/or Abeyance — Short-Term (1-10 Days)
*QUT-OF-SCHOOL SUSPENSIONS ARE SUBJECT TO LIMITATIONS DESCRIBED ON PG 17
o Department of School Safety may be contacted in Appropriate Circumstances
Any Action from the prior level(s) may also be imposed.
b o Out of School Suspension and/or Abeyance — Long-Term (11-30 Days)
w *OUT-OF-SCHOOL SUSPENSIONS ARE SUBJECT TO LIMITATIONS DESCRIBED ON PG 17
E o Restorative Conference and/or Restorative Circle (upon re-entry to school)
o Removal By Hearing Officer For Likely Injury To Self Or Others
o Removal By Student’s IEP Team To An Interim Alternative Education Setting
Any Action from the prior level(s) may also be imposed.
o o Out of School Suspension and/or Abeyance — Long-Term (11-180 Days)
U>J *QUT-OF-SCHOOL SUSPENSIONS ARE SUBJECT TO LIMITATIONS DESCRIBED ON PG 17
o o Restorative Conference and/or Restorative Circle (upon re-entry to school)
o Expulsion
o Parent Notification o Detention (before or after school) Reassignment To Different Class

Behavior Contract
Behavior Intervention Group
prdag-Term (11-38@R2gyk) Threat Assessment
d ﬁsumﬁ@?@ﬂm@ITATlONs DESCRIBED ON @17  Behavior Intervention Plan
(upon re-entry to school 0 Lunch Detention

ssessmen o Monitoring of Selected Problem
mmﬁcmBEDONPG1?““““

Wégraingent of School Safety may be cal‘l’tactedw Kppropriate Circumstances Ottrer Actiom tconststent vt
ay

Referred to Outside Agency RETECUVE T
o Meeting With School Counselor

o Community Service(not work detail)

AmpPeiendrom thepriprdevel(s) may also beimposeebr Mediation

Student Conference 0 Privileges Suspended
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LEVEL 5

OttTer tevet-Timterverntions and approved by te
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Violation Action Level
1

Recklessness

Unintentional, careless behavior that may pose a safety or health risk for yourself or for

others.
Minor Aggressive Act 2
Student engages in non-serious but inappropriate physical contact.
Examples: hitting, poking, pulling, tripping, or pushing.
Other Aggression 3
Includes other acts of aggression not specifically listed within the Aggression section
including, but not
limited to, serious and inappropriate physical contact.
Examples: pulling a chair out from underneath another person, or other behaviors that
demonstrate low-level hostile behaviors.
3

Disorderly Conduct
A person commits disorderly conduct if, with intent to disturb the peace or quiet
of a neighborhood, family or person, or with knowledge of doing so, such person:

a. Engages in violent or seriously disruptive
behavior.

b. Uses abusive or offensive language or gestures
to any person present in a manner likely to
provoke immediate physical retaliation by such
person.

c. Makes any protracted commotion, utterance or
display with the intent to prevent the
transaction of the business of a lawful meeting,
gathering or procession.

d. Refuses to obey a lawful order to disperse
issued to maintain public safety. (see A.R.S.
§13-2904)

e. Recording/distributing fights on any social
media outlet.
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How We Respond

T
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Questions?

Informational Presentation about our School’s
Culture, Student Expectations, and Discipline.
SY 2014-15 USP VI D2
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Informational Presentation about
our School’s Culture, Studen
Expectations, and Discipling
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Establish
Common
Expectations

e —
Preventative
!ﬁm Approach
Consistently Ongoing
Encourage and Reinforcement
Communicate and Recognition
Creates a

positive, safe
school climate to
maximize success

Example of PBIS — Matrix of Expectations

SETTING
Library/
All Settings | Hallways | Playground | Cafeteria | Computer | Assembly Bus
Lab

Respect
Ourselves

Respect
Others

EXPECTATION

Respect
Property
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5 building,
) . lonships across
school cormmunities through positive changes
in behavior.
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The Purpose of The Guidelines for Student
Rights and Responsibilities

Explains the rights and responsibilities of students

Describes behavior which violates the rights and
responsibilities

Aims for consistency throughout the District

Assures the rights of students when disciplinary action is taken
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o Parent Notification o Detention (before or after school) | o Reassignment To Different
and Conference Request o Peer Mediation Class
o Student Conference o Privileges Suspended o Behavior Contract
o Restorative Circle o Restitution o Behavior Intervention Group
o Restorative Conference o Saturday School o Threat Assessment
- [} Confiscation of [¢] Teen Court [} Behavior Intervention Plan
il Contraband o Functional Behavioral o Lunch Detention
% o Student Verbal Apology Assessment o Monitoring of Selected
- o Student Written Apology | o Behavior Learning Packets Problem
o Warning o Time Out Behaviors
o Referred to Outside o Reflective Essay o Other Action (consistent with
Agency o Meeting With School Counselor other Level 1 interventions and
o Community Service (not work approved by the RPPSC).
detail)
«~ Any Action from the prior level(s) may also be imposed.
m o Restorative Conference and/or Restorative Circle
@ o Social Skills Groups and/or Mentoring
- o In School Suspension (1-3 days) only after Restorative Practices have been implemented and documented
but deemed ineffective
Any Action from the prior level(s) may also be imposed.
- o Short-Term In School Action and/or Abeyance
z o Restorative Conference and/or Restorative Circle
z o In School Suspension — Short-Term (1-10 Days)
=} o Out Of School Suspension and/or Abeyance — Short-Term (1-10 Days)
*OUT-OF-SCHOOL SUSPENSIONS ARE SUBJECT TO LIMITATIONS DESCRIBED ON PG 17
o Department of School Safety may be contacted in Appropriate Circumstances
Any Action from the prior level(s) may also be imposed.
S o Out of School Suspension and/or Abeyance — Long-Term (11-30 Days)
g *OUT-OF-SCHOOL SUSPENSIONS ARE SUBJECT TO LIMITATIONS DESCRIBED ON PG 17
o o Restorative Conference and/or Restorative Circle (upon re-entry to school)
o Removal By Hearing Officer For Likely Injury To Self Or Others
o Removal By Student’s IEP Team To An Interim Alternative Education Setting
Any Action from the prior level(s) may also be imposed.
© o Out of School Suspension and/or Abeyance — Long-Term (11-180 Days)
g *OUT-OF-SCHOOL SUSPENSIONS ARE SUBJECT TO LIMITATIONS DESCRIBED ON PG 17
o o Restorative Conference and/or Restorative Circle (upon re-entry to school)
n Fyniilcinn
[} Parent Notification o Detention (before or after school) o Reassignment To Different Class
AmpActiondromtheqrigrdevel(s) may also beoimposee:r Mediation o Behavior Contract
j o Student Conference o Privileges Suspended o Behavior Intervention Group
g 2} { pOartEtHolNA 1t Btecag-Term (11-38@CR2gyk) o Threat.Assessmem‘
o ° o ﬁsﬂmﬁ@MlTAﬂONs DESCRIBED ON Ha17  Behavior Intervention Plan
) @ e (upon re-entry to school 0 Lunch Detention
° en Monitoring of Selected Problem
3 8D tESCRIBED ON PG 177
6 Déimmﬂent of School Safety may be caMactedW'&ﬁﬁprrlate Circumstances Ottrer Actiom tconststent vt
o Referred to Outside Agency RETIECUIVE TS5y otfertevettTimterventionsand Approvet oy tume
o Meeting With School Counselor RPPSC).
o Community Service(not work detail)
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Violation Action Level
1

Recklessness

Unintentional, careless behavior that may pose a safety or health risk for yourself or for

others.
Minor Aggressive Act 2
Student engages in non-serious but inappropriate physical contact.
Examples: hitting, poking, pulling, tripping, or pushing.
Other Aggression 3
Includes other acts of aggression not specifically listed within the Aggression section
including, but not
limited to, serious and inappropriate physical contact.
Examples: pulling a chair out from underneath another person, or other behaviors that
demonstrate low-level hostile behaviors.
3

Disorderly Conduct
A person commits disorderly conduct if, with intent to disturb the peace or quiet
of a neighborhood, family or person, or with knowledge of doing so, such person:

a. Engages in violent or seriously disruptive
behavior.

b. Uses abusive or offensive language or gestures
to any person present in a manner likely to
provoke immediate physical retaliation by such
person.

c. Makes any protracted commotion, utterance or
display with the intent to prevent the
transaction of the business of a lawful meeting,
gathering or procession.

d. Refuses to obey a lawful order to disperse
issued to maintain public safety. (see A.R.S.
§13-2904)

e. Recording/distributing fights on any social
media outlet.
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How We Respond

T
'Ei Rights and
—_— Responsibilities

| NS
[ ] Practices
- Positive Behavioral
Sh%l::p?l:: :_)ave e Intervention and
. — Supports

equences be
e ent?

cons:
0 1 gdent:

How can the
student repair th

Our Mission
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» a right of a student and parent
! be suspended or expelled.
'he school has an obligation to follow this process
to protect a student’s rights

SHsHRS
%entry
conference to
review the
expectations for
student conduct

. th hool and provide
R !' REN00 I supports to assist
mﬂ:&ﬁe the success of the
violations and the BtuppRfided only student.
condmon§ of the after the student
suspension.

has completed and
returned previous
assignments.

*Only in extreme situations involving safety can disciplinary action be taken before these steps
are completed.
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If the suspension has been upheld
or modified after the initial appeal,
the student may further appeal by

filing a written notice of appeal to

PSSR APeRd - the Governing Board within five (5)
days after receiving the decision of
Elementary, K-8 or Secondary
Leadership.

The student may appeal a decision
imposing a long-term suspension by
filinrayciitenaoneal with the
BLCACII i5ice of Eiemeniary, K-8 or
Secondary Leadership within three

Long-Term =

or within a time limit agreed upon’
by the student and the Office of
Elementary, K-8 or Secondary

eadership duringillN
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Ste

The majority of issues are resolved in

the classroom through student and

iy I

Questions?

Informational Presentation about our School’s
Culture, Student Expectations, and Discipline.
SY 2014-20147 USP VI D2
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